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StarTeam Release Notes 

These release notes contain information that might not appear in the Help. Read them in 

their entirety before you install the product. 
 

  Note: This document contains a number of links to external web sites. Micro Focus 

cannot be responsible for the contents of the website or for the contents of any site to 
which it might link. Web 

sites by their nature can change very rapidly and although we try to keep our links up-

to-date, we cannot guarantee that they will always work as expected. 

  



What's New  | 7  

What's New 

 
17.0 

The following are the new features in this release. Micro Focus replaces Oracle’s Java 8 with Azul System’s OpenJDK. 
All the sub components of StarTeam will ship with Zulu OpenJDK. 

 
StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

Pulse Code Review Capabilities 

StarTeam 17.0 introduces Code Review capabilities. Pulse enables development teams to continuously examine the 
health and quality of their changes and decide if the changes are ready to be merged or released: Team members can 
not only collaborate to conduct peer reviews of code changes but also view recent activity in projects and views. 

 

Refer to Section Configuring Pulse Code Review  in Server guide (ST_Server_Help_en.pdf) on how to install Pulse.  

 

IMPORTANT: You need to configure Pulse either as an Administrator or as a user with Administrator 
Privileges. Micro Focus strongly recommends restarting  “StarTeam Search Web Service” running on 
StarTeam Server Machine after configuring Pulse. 

 

After the installation, the Pulse web application is configured to run as a service with the name ‘ StarTeam Search 
Web Service’. 
Please use the URL http://<machine name>:< RESTServicePort>/pulse/ to login to the service. 
The default RESTServicePort, as configured, is 9090. Please verify this with your System Administrator. 
Pulse is configured to use StarTeam authentication.  
When logging in through the browser, you will need to provide your StarTeam credentials to connect. 
When logging in through the CPC, the credentials are automatically accessed from the local credential cache. 
 
Note that only the StarTeam user whose credentials are used to configure Pulse has Pulse admin privileges granted. 
Only the user with Pulse administrative privileges can register StarTeam Projects in Pulse.  
 
Also note that StarTeam Projects must be registered in Pulse (using the browser based web UI) before the code review 
functionality is accessible, either from a browser or the StarTeam CPC. 
 
To register a StarTeam Project in Pulse  

1. Login to Pulse via a browser. Use the URL  http://<machine name>:< RESTServicePort>/pulse/ with pulse 
administrative privilege 

2. Go to Suites and select Main suite 
3. Click Register button and select Single / Multiple Products.  

Note: Pulse Product corresponds to StarTeam Project. Refer to Pulse User Guide (ST_Pulse_Help_en.pdf)  for more 
information. 

4. Select StarTeam repository  
5. Select StarTeam project / projects for which you want to enable Pulse Code Review capability and save. 

Now you are fully set to use code review capability. 

 

  

Refer to section Pulse Code Review in the CPC documentation for more details on how to use Pulse Code Review 



What's New I 8 |   

from StarTeam CPC. 

Refer to Pulse User Guide (ST_Pulse_Help_en.pdf)  for more information on this exciting technology 

 

IMPORTANT: Micro Focus Pulse Code Review only works with ActiveMQ Message broker. Customers who 
currently use Tibco Smart sockets based Message Broker should upgrade their Message Broker to ActiveMQ 
before they can use Code Review feature.  

 
Support for Light Weight Views  
StarTeam 17.0 adds support for light weight views. ( See section View Configuration and Management in the CPC 
documentation for more details) 
 
Support for Credential Caching 
StarTeam 17.0 now supports Credential Caching. This replaces the StarTeam Tool bar. 

  

Bulk Edit support for Custom Forms 
Custom forms now support bulk updates.  

 
Bulk Notification support for File Component 

If a StarTeam user registers for notifications for multiple files, StarTeam Server will send only one notification for all the 
registered files. 

 
Deleted shares in Label Tab 
Deleted shares are now visible in the label tab 

 
Rename folder option 
Rename Folder option has been added to Folder Context Menu 

 
Client Auto Update Feature Enhancements 
When downloading a client update, multi choices are available to either directly install or open installer folder, and run 
the installer at elevated privilege 
Ability to pick the highest dot notation update file from 2 or more client update files checked into Starflow extensions 
project 

 
Requirement Component Tab enhancements 
Rich Description Content Property is added to Requirement Component Tab 

 
StoryID property is visible in CPC UI 
StoryID property has been added in Story Property TAB, Links TAB and Item Info in Audit Pane 

 
Folder access rights enhancements 
User can Clone folder access rights across project/view folders 

Set folder access rights in bulk by allowing selection of multiple folders 

 
Bulk Notification Enhancements  
Bulk notify menu option added at folder level to update notification user list for all contained files 

 
StarTeam Git Client 
The following are the new features for this release of the StarTeam GIT Client 
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Support for Credential caching for GIT clients running on Linux Platform 
StarTeam GIT Client now supports Credential Caching for GIT clients running on Linux Platform. 16.3 release added 
Credential caching support for Windows. 

 
StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

StarTeamMPX (Tibco SmartSockets) will no longer be supported on Windows 
2012 and Windows 2016 platforms  
StarTeam 17.0 does not support StarTeamMPX (Tibco SmartSockets) for StarTeam Servers running on Windows 2016 
and Windows 2012. Currently this technology is only supported for StarTeam servers running on Windows 2008 R2. 
Customers currently using StarTeamMPX (Tibco SmartSockets) and running their Servers in Windows 2016 or Windows 
2012 platforms should migrate their StarTeamMPX servers to ActiveMQ based Message brokers. This should be done 
during the upgrade to 17.0. It is strongly recommended to review ActiveMQ MPX Guide and read the section Configuring 
MPX to use ActiveMQ MPX to migrate your Message Broker Technology. 

Support for multiple AD Servers 

StarTeam Server now supports multiple Active Directory Servers. Server Administrators can use Directory Service TAB 
under “Configure Server” menu option to setup the secondary AD server. Please note that a user can be defined in 
only one AD server. The Server Administrator can specify the AD Server on a per user basis in the Logon Tab of the 
User Properties in User Manager. Please note that this option will only be visible when StarTeam Server Administrator 
has setup the secondary AD Server. 

 

Support for AutoPass License Server 

StarTeam Server now supports a new centralized license server. Customers currently using BLS/FLEX LM should 
seriously consider moving to AutoPass License Server. Please refer to section “Licensing the Server” in Server guide 
(ST_Server_Help_en.pdf) for more information on how to use this technology.  

 

Bulk Notification support for File Component 

If a StarTeam user registers for notifications for multiple files, ST Server will send only one notification for all the 
registered files. 

Server Statistics Monitoring 

StarTeam Server now supports all browsers for this feature. For more information about this feature or how to configure 
it, please refer to “Monitoring Server Statistics” section in Server guide. 

User Logout Time 

StarTeam Server Administration’s User Manager now displays the last logout time in the user list. 

Enhanced Email support 
Added Reply-To Email setting. This can be set on a per user basis in the Logon Tab of the User Properties in User 
Manager The Reply-To field will be set accordingly when sending emails 

 

Added a new server config option to send all server emails and notifications from same predefined email address. If 
set, all emails will be sent using this address.  When using this option, you can also  set "reply-to" to the real sender 
email address 

Setting is <option name="SMTPSenderAddress" value="admin@xxx.com"/> 

 
StarTeam Datamart 
The following are the new features for this release of the StarTeam Datamart 

mailto:admin@xxx.com
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Datamart is now bundled with StarTeam Server.  
StarTeam Datamart is also available with StarTeam Server. Refer to section “Configure Datamart” in Server guide 
(ST_Server_Help_en.pdf) on how to use this feature. Please note that stand alone Datamart installer which will 
continue to ship. 
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16.3 
The following are the new features in this release. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

New -iip Parameter in the co Command 

The new -iip parameter allows you to ignore invalid path, specifically when describing rolled back or labeled 

configurations. 
 

Updates to merge-label Command to Use -rollupLabels or -sourceview 

The merge-label command can now be used in two different ways. 

• When used with -sourceview: The merge-label command creates a new label, if one does not already 

exist, in the target view, copying the properties of the source label from the source view. After the label has been 

created, the command finds the items in the source view attached to the source label, identifies the set of items 

in the target view that need to be attached to the target label, attaches them at the tip, and moves them back to 

the revision at which the items were attached in the source. 

While this command supports both view and revision labels, it is more useful for view labels (which are not 

supported through the StarTeam Cross-Platform Client ), unlike (cross-project) Revision Label copy, which is. 

This command supports attaching labels both to items that have been shared across (in-project) views as well as 

to items that have been moved across projects. 

• When used with -rolluplabels: The merge-label command creates a new label, if one does not already 

exist, in the target view. After the label has been created, the command rolls up all the revisions of all items of the 

selected type spanning all the labels and attaches them to the new label at the highest item revision identified. 

 

StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

Fast View Compare/Merge Rebase and Promote 

The View Compare/Merge now has Fast Rebase and Promote menu options. This enhancement provides significant 

performance improvements while performing a full view rebase or promote. 
 

Support up to Five Property Groups per Filter 

StarTeam now supports up to five property groups per filter 

Read-only File of Revision Label History 
 

Cross-Platform Client now provides and option to launch a read-only file pane containing the historical 

revisions attached to a revision label. 
 

Email Supports Rich Text Formatting with Attachments 

Emails sent from the StarTeam Cross-Platform Client now support rich text formatting with attachments. 
 

View Compare/Merge Enforces Change Packages 

Full View VCM (View Compare/Merge) has been optimized to take advantage of Change Package 

enforcement. 
 

Directly Rename Files in StarTeam 
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The Cross-Platform Client File menu now provides an option to directly rename a file inStarTeam. 
 

Assign Custom Field Values when Checking in Files 

You can now assign custom field values when checking in files. 
 

Enhanced Link Handling 

Old style links can now either be pinned or float at checkin. Additionally, existing links can be updated or 

new links can be created on each checkin. 
 

Flagging Change Packages 

Flag or unflag change packages from a menu option. 
 

Close Window with Shift Key 

View Frame Windows can now be closed directly from the Window Sub-menu view list, using the Shift key. 

It is no longer necessary to select the window to close it. 

 

StarTeam Git Client 

StarTeam Git Client 
 

  Note: The StarTeam Git Connector command line utility from the 16.2 release will be deprecated in a 

future release. 

The StarTeam Git Client brings centralized source code control and security to teams using Git clients. Git 

users can connect to the StarTeam Server using the regular Git commands to push and pull changes with 

their local Git repository. Teams are able to share Projects in StarTeam such that developers can work 

synchronously either with their favorite Git clients or StarTeam clients. 

With the StarTeam Git Client, developers can: 

• Use the clone command to clone a StarTeam View and its immediate child views as branches into a 

local Git repository. 
 

  Important: The clone command initializes the developers local Git workspace and allows them to 

issue further commands to interact with the StarTeam View content. User credentials specified 

during the clone command will be cached and re-used during subsequent fetch, pull, and 

push commands from the same local repository unless a different username or password is 



What's New  | 13  

specified during those commands. However, caching of credentials is only available on Microsoft 

Windows platforms and all commands issued from Linux must specify a username and password. 

• Use the fetch and pull commands to update a local Git repository with changes from StarTeam. 

When you pull changes, each StarTeam Change Package becomes a commit in a local Git repository. 

History is pulled over to Git. 

• Use the push command to push changes from a local Git repository into StarTeam Server. Each Git 

commit becomes a StarTeam Change Package, including the user ID, timestamp, and comment. History 

is carried over to StarTeam. 

• Git tags are pushed into StarTeam as Labels. 

 
Benefits 

• Developers are able to use their preferred Git client tools on a local Git repository while connecting with 

the centralized StarTeam source code control system using the StarTeam Git Client. 

• Enterprises retain what StarTeam offers: rich change management, ALM traceability, 

Issue/Process enforcement, global distribution (Cache agent), security (Access rights) and 

visibility.. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

Support for IPv6 

StarTeam Server now supports Internet Protocol version 6 (IPv6). 
 

Remote Cache Agent Supports Copy of Vault 

The remote cache agent now supports access to a copy of the vault, if available. 
 

Support for Active Directory 2012 

StarTeam Server now supports Active Directory 2012. 
 

Automatic Email for File Versioning 

When a file is updated with a new version, and email is automatically generated and sent to users within 

the User Resource list. The User Resource list is defined per file. 

 

StarTeam SDK 
The following are updates for this release of the StarTeam SDK: 

 

StarTeam REST Service 

StarTeam offers a REST service in the SDK to allow you to build an REST application against the 

StarTeam Server. 

The StarTeamRESTService.war is located in the StarTeam SDK's \lib folder. 

To use he .war file: 

1. Copy the StarTeamRESTService.war to the Tomcat webapp folder. 

2. Create an .xml file with the following signature, and save it anywhere on disk. 

3. Change the values to reflect the StarTeam server and administrative credentials. 
 

 

<?xml version="1.0" encoding="UTF-8"?> 

<server> 

<hostname> localhost </hostname> 

<port> 49201 </port> 
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4. Create an environment variable called StarTeamRESTConfiguration, where the value is the path to 

the .xml file. For example, c:/temp/StarTeamREST.xml 

5. Create an environment variable called StarTeamRESTConfiguration, where the value is the path to 

the .xml file. For example, c:/temp/StarTeamREST.xml 

6. Stop and restart tomcat. 

7. Verify that the REST service is running via a browser on this same machine. Use Google Chrome, 

Internet Explorer, Netscape Navigator, or etc. 

8. Type the url in the borwser: http://localhost:8080/StarTeamRESTService/rest/users/ 

logon?username=Administrator&password=Administrator. If the REST Service is running, 

you will get a session ID, which can then be used to run further tests or to develop StarTeam web 

applications. 

The REST APIs currently available are fully documented on the community. Additional APIs are available 

on request. https://community.microfocus.com/borland/managetrack/starteam/w/wiki/28946/a-generic- 

starteam-rest-service 

 

 

16.2 
The following are the new features in this release. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

New Parameter -pi 

A new -pi parameter has been added for add, ci, and sync commands. When adding -pi 

typename:"path", the type name is the internal name of a component that supports being a process 

item type, for example change request, task, requirement, story, custom component name. 
 

New Parameter: rolldown 

In the Select command, rolldown can only be specified for tree item types. When specified, the 

children of the selected tree items (specifically, the entire tree of descendants) are added to the result set. 

 

StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

Support for Red Hat Enterprise Linux 7.3 

StarTeam Cross-Platform Client now supports Red Hat Enterprise Linux 7.3. 
 

Configuring Projects to Create Workspace Change Packages 

StarTeam Cross-Platform Client now provides a way control workspace Change Package creation at the 

project-level. If the feature is enabled (the default), then Change Packages are created when files are 

checked in, folders are created, and etc. The feature behavior changes depending on the StarTeam Server 

configuration in the starteam-server-configs.xml file. 

Refer to the Project section, Configuring Projects to Create Workspace Change Packages topic, of the 

StarTeam Cross-Platform Client help for more information on how to use this feature. 

<user> Administrator </user> 

<password> Administrator </password> 

</server> 

https://community.microfocus.com/borland/managetrack/starteam/w/wiki/28946/a-generic-starteam-rest-service
https://community.microfocus.com/borland/managetrack/starteam/w/wiki/28946/a-generic-starteam-rest-service
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Favorite Projects 

StarTeam Cross-Platform Client now provides the ability to save projects to Favorites, making it easy to 

return to frequently used projects. 
 

Server Outage Information Available Through StarTeam Cross-Platform 

Client 

Server outage information is now available through StarTeam Cross-Platform Client. 

 

StarTeam Git Client. 
The StarTeam Git Client brings centralized source code control and security to teams using Git. Git users 

can connect to the StarTeam Server using the command line utility to push and pull changes with their local 

Git repository. Teams are able to share Projects in StarTeam such that developers can work synchronously 

either in Git or StarTeam clients. 

With the StarTeam Git Client, developers can: 

• Use the clone command to clone a StarTeam View as master and selected child views as branches. 
 

  Important: The clone command initializes the developers local Git workspace and allows them to 

issue further commands to interact with the StarTeam View content. User credentials specified 

during the clone command will be cached and re-used during subsequent fetch, pull, and 

push commands from the same local repository unless a different username or password is 

specified during those commands. However, caching of credentials is only available on Microsoft 

Windows platforms and all commands issued from Linux must specify a username and password. 

• Use the fetch and pull commands to update a local Git repository with changes from StarTeam. 

When you pull changes, each StarTeam Change Package becomes a commit in a local Git repository. 

• Use the push command to push changes from a local Git repository into StarTeam Server. Each Git 

commit becomes a StarTeam Change Package, including the user ID, timestamp, and comment. 

 
Benefits 

• Developers are able to use their preferred Git client tools on a local Git repository while connecting with 

the centralized StarTeam source code control system using the StarTeam Git Client. 

• Enterprises retain what StarTeam offers: rich change management, ALM traceability, 

Issue/Process enforcement, security, and visibility. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

Offline Proxy Utility 

Use the new Offline Proxy utility to communicate to StarTeam users that the server is down for 

maintenance. Previously, when StarTeam Server is down due to database issues or maintenance, a user 

connecting with StarTeam SDK or StarTeam Cross-Platform Client gets a message stating, "Unable to 

connect to server." Since they do not know what the reason is, they might raise issues with their IT 

department . When using the Offline Proxy utility, administrators can better communicate the reason for the 

disruption in the Server, avoiding unnecessary IT service tickets. 
 

Server Message Notification 

The new Server Message Notification alerts users when logging in or when the StarTeam Offline Proxy is 

running. Configure the message from the Server Administration Tool Configuration. 
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Server Hooks 

Server hooks are scripts that run automatically every time a particular event occurs in the StarTeam Server 

repository. Server hooks allow the user to trigger customizable actions at key points in the development life 

cycle. For more information, refer to the "Server Hooks" topic in the Server Administration Help. 
 

Custom Component Builder Enhancements 

StarTeam Server now provides the ability to add Primary Descriptors and Secondary Descriptors using 

Custom Component Builder. 
 

Support for Oracle Database Character Set AL32UTF8 

StarTeam Server now supports Oracle database character set AL32UTF8. 
 

Support for Oracle Database 12c Container Databases 

StarTeam Server now supports Oracle Database 12c container databases. 
 

Support for Oracle 12c version 12.2 

StarTeam Server now supports Oracle 12c version 12.2. 
 

Support for SQL Server 2016 

StarTeam Server now supports SQL Server 2016. 
 

Support for Microsoft Windows Server 2016 

StarTeam Server now supports Microsoft Windows Server 2016. 
 

Support for PostgreSQL 9.6 

StarTeam Server now supports PostgreSQL 9.6. 
 

De-support of Object Caching on Server 

Object Caching is de-supported on the server. StarTeam Server will ignore ObjectTypes Setting 

setting defined in CacheAgentConfig.xml file for all cache agents which include root and remote cache 

agents. 

 

Workflow Extensions 
The following are the new features for this release of StarFlow Extensions. 

 

New Controls for Extensions guicomponents.jar 

New controls have been added to the extensions guicomponents.jar. The controls are: 

• MultiSelectCheckBoxControl 

• UserListPropertyEditor 

• ContentEditor 

For more details, refer to the Workflow Extensions User's Guide. 

 

StarTeam Web Client 
The following are the new features for this release of the StarTeam Web Client. 
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New File Service Button in File List Perspective 

The StarTeam Web Client File List perspective now has a Use File Service button. 

This is a toggle button that indicates whether you want to use file service or not. 

When the button is not clicked, the file list loads without file statuses. 

If you want to use the file service, click the Use File Service button and click Refresh. The File Service 

launches and file statuses, check in, and check out files is visible. 

 

 

16.1 Update 1 
The following are the new features in this release. 

 

StarTeam Eclipse Plugin 
The following are the new features for this release of the StarTeam Eclipse Plugin. 

 

StarTeam Eclipse Plugin Now Supports Stories 

StarTeam Eclipse Plugin now supports Stories, giving you the ability to: 

• List Stories 

• Create, edit, and delete Stories 

• Modify Story properties in the Item Editor, including support for Rich Text. 

• Access Story Preference page 

• Edit Rich Text using Content Property 
 

StarTeam Eclipse Plugin Available for Download Only 

The installation for StarTeam Eclipse Plugin is available only from the Micro Focus Update site: http:// 

altd.borland.com/update/starteam16/4.4. 

 

StarTeam Quality Center Synchronizer 

Support for 64-Bit Quality Center Synchronizer 

StarTeam now supports a 64-bit Quality Center Synchronizer. 
 

 

16.1 
The following are the new features in this release. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

Add-User Command 

Three new parameters have been added to the add-users command: 

-distinguishedname User's directory service distinguished name 

http://altd.borland.com/update/starteam16/4.4
http://altd.borland.com/update/starteam16/4.4
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-directoryservicevalidation If specified, turns on directory service validation. 

-fixedlicense If specified, sets the user to inherit a fixed license. 

 

Update-User Command 

Use the update-user command to update a user properties on the StarTeam Server. 

Either -logonname or -userid are required to identify the user. All other parameters are optional. 

If specified, the new property will be applied to the user. 

Only users with administrative privileges can run this command on behalf of any user. 
 

Manage-User Command 

Use the manage-user command to manage another user. The command must be run by an administrator, 

and must specify the logon name of the user being managed. 

It is not possible to manage your own account with this command unless you are changing a password with 

-changePassword. 
 

Select Command 

The Select command now contains new queries: 

attachments Use this option to generate a report identifying all the attachments by name, ID, size, 

and md5 for each item in the select list. 

duplicate-shares  Use this option to override properties. If specified, it generates an exception report of 

all items which are shares of each other in the selected view. 

missing-artifacts  Use this option to override properties. If specified, it generates an exception report of 

all items which are not attached to he label (specified by attached-to-label) in the 

selected view. 

 

Share Command 

The Share command shares any StarTeam artifact from one view to another view, from a folder to another 

folder in the same view, and etc. The Share command returns the item ID of the newly created share. 
 

Attachment Command 

Use the attachment command to attach an item to a change request, task or requirement. 
 

Check Out Command 

A new parameter, -chgpkgid 1234567, has been added to the co command. 

If specified, the checkout is based on a committed change package, with the specified view member ID. 

All files attached to that change package are checked out at the revisions they were at when the change 

package was committed. 
 

Make Public Command 

Use the make-public command to convert private filters or queries to public. 
 

Reorganized Command Line Help 

Common options no longer reside in a separate topic. Common options appear among options within each 

command, making it easier to select options while working within a command's help topic. 
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StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

Support for Microsoft Visual Studio 2017 

StarTeam now supports Microsoft Visual Studio 2017. 
 

Bulk Updates 

Edit multiple items of a particular type in bulk (as a group). 

For example, you can update three Change Requests status collectively to Finished. 

This feature has a new Bulk Update menu item, and is available for Change Request, Requirements, 

Tasks types, and custom components. 
 

Search Supports Wildcard Queries 

Search now support wildcard and prefix queries. 
 

Search Using Display Name of Property 

Search now supports the use of property display name. In past releases, search queries of the type 

field:value were possible only on internal field names. Now, the field parameter accepts input of the 

property's display name. 
 

Auto Client Update 

Administrator's can distribute StarTeam Cross-Platform Client updates to each client. To run the update, 

choose Download Client Update from the Help menu. 
 

Ability to Turn Private Filters to Public Filters 

StarTeam now provides the ability to turn private filters into public filters. 
 

Full View Name Displays in Results 

The full view name now displays in the search result page for each matching artifact. 
 

Matching Artifact Field Displays in Results 

The matching artifact fields from the search query now displays in the result page. 
 

Distribute starteam-client-options.xml through StarFlow Extensions 

Check starteam-client-options.xml into StarFlow Extensions to ensure all clients use customized 

personal option values. The users need to have access right permissions to see StarFlow Extensions 

project and to see and check-out the files in order to use the functionality. 

  Note: Do not use options in the starteam-client-options.xml that are path specific. 

Ignore Files 

Ignore acts as a note to self to ignore the marked files. It does not change any functionality within the files 

or within StarTeam. You can restore files back to their StarTeam status when you are done ignoring them. 
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VCM Skip a Revision 

Skip-a-Revision feature has been modified to show an extra "In scope" column. If the VCM session is 

scoped with Process item, the revisions that include the process item will be marked with red triangles. 
 

Use Last Modification Time for Folders During Checkout 

Using last modification time for folders during check out uses the last modification time when Working 

folders are created. Otherwise, the current time is used. To select or deselect this option, go to Personal 

Options. 
 

Sort Open Window by Name 

You can now sort the opened windows by name. Windows are sorted by the order in which they are 

opened as default. To activate this option, go to Personal Options. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

Enable Sandbox Server Search 

A new configuration option has been added to starteam-search-configs.xml to exclude items in a 

sandbox type view from being indexed/searched. Refer to Search Index Configuration topic in the Server 

Administration Help. 
 

Project Access Rights 

You can now configure project access rights from the Server Administration tool. The areas you can 

configure are: 

• View/edit project access rights 

• User access rights report 

• Clone Project rights 

• Clone view rights 
 

Enable SDK Workflow Server Configuration Option 

If Enable SDK Workflow is turned on, SDK Workflow is enabled. Refer to Managing Log and Initialization 

Files and the starteam-server-configs.xml in the Server Administration Help. 
 

Upgrade Distribution through StarFlow 

A new Client Upgrade feature allows StarTeam administrators to easily make StarTeam Cross-Platform 

Client releases available to their user base. To distribute: 

Check the StarTeam Cross-Platform Client release build(s) into the StarTeam Server, StarFlow Extensions 

project, default view, root folder. 

The build file names are required to follow specific patterns which are described below: 
 

 

Installer Type Build File Name 

64 bit windows 

32 bit windows 

Linux client 

Mac Client 

starteam-cpc-win64-{nn.mm.oo.pp}.exe 

starteam-cpc-win32-{nn.mm.oo.pp}.exe 

starteam-cpc-ux-{nn.mm.oo.pp}.tar.gz 

starteam-cpc-mac-
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PostgreSQL 

New script starteam_postgres_create_compute_stats.sql added to this release. 

starteam_postgres_create_compute_stats.sql Updates query optimization 

statistics. Updating statistics 

ensures that queries compile 

with up-to-date statistics. Can 

be run online or offline. 

starteam_postgres_create_index_maintenance_script.sql Rebuilds indexes. Can be run 

online or offline. 

 

Analyze Server Log or Analyze Archived Server Logs 

Analyze Server Log and Analyze Archived Server Logs are new menu options for Server Administration, 

under Tools > Administration. These new Administrative user options analyze the server log(s) and 

report the connections usage over time. These options can also be used by launching the Server 

Administration Tool bundled with the Windows version of StarTeam Cross-Platform Client. 

 

 

16.0 
The following are the new features in this release. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

Select Command 

The Select command now contains new queries: 

changed-files Use this option to generate a software lines-of-code count report. 

 

Update-Property Command 

Updates the display name of any StarTeam property on any type. 

 

StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

Change Request User Lists Only Show Active Users 

From version 16.0 onwards (client and server), all user lists, such as Responsible Users for a Change 

Request, exclude Suspended or non-active users. 
 

Full Change Package Rollback 

The new Rollback menu item in the Change Package perspective rolls back all of the files attached to the 

committed Change Package. 

A new workspace Change Package is created and can be committed. The revision attached to the Change 

Package is reverse merged out of the tip content. The reverse merge process itself is manual. You are 

prompted to run the merge using the Delta II tool. When the reverse merge is complete, the updated 

content is stored as part of the session. When committed to the current view, you get the desired effect. 
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Multi-Select Context Menu 

The new multi-select context menu options help moving or sharing items across projects or views. This 

new UI provides an alternative to the traditional drag-and-drop approach. 
 

Spell Checker 

The new spell checker component tracks text as it is typed in multi line text fields, such as Task Notes and 

Change Request Synopsis. It underlines incorrectly spelled words using a red wavy font and offers 

suggestions for correction. To toggle the spell checking option, check your Personal Options. 

This is supported in English, French, German and Portuguese. 
 

Symbolic Links 

The File type now contains a symbolic link property. If content is checked in or out via a symbolic link, the 

address of the target is stored in the new property value. 
 

Support for Mac Client 

The StarTeam Cross-Platform Client now supports the Mac client. See the StarTeam Cross-Platform Client 

System Requirements for supported versions. 
 

VCM Commit with Full History 

Multiple revisions of a file (it's history) can be propagated to the parent view during a VCM promote 

session. This is typically likely if you have checked in multiple versions of a branched file in the child view, 

and then you ran the promote and want to carry the history of all subsequent revisions since the last 

promote. 

Since the historical revisions in the child view may have been created by other users (than the user doing 

the commit), the person performing the commit must be granted impersonation rights at the server. 

This feature can only be turned on at the project level using the new project option: Merge File History 

during VCM commits, and is supported on StarTeam Server versions 16.0+. 
 

VCM Content Differences Display 

The File Content differences pane for File Compare/Merge operations has been expanded to include two 

new panes. The first pane displays the file content differences between the Source File and the Common 

Ancestor picked for the merge. The second pane displays the file content differences between the 

Common Ancestor and the Target File. 
 

VCM Process Item and Attached Revisions 

The VCM wizard has been expended so that if a Story is used as an aggregator (rollup) of attached 

process items, the Story resolves to in-view Tasks created by Agile, and the in-view Tasks are used as 

cross project process items to files in a completely different view. A Sprint can be used for VCM as an 

aggregator of attached Stories. The attached Stories follow the same rules. The VCM wizard automatically 

changes its context to the project/view in which the files reside, and runs the VCM session for the attached 

files. 
 

VCM Skip Multiple Revisions 

The Skip-A-Revision feature in VCM has been modified to support skipping multiple revisions. Each 

selected revisions needs to be reverse merged out of the content using the merge tool Delta aII. 
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Workspace Modified Time 

The StarTeam Server has introduced a new property on the view called Workspace Modified Time. 

This property value is automatically updated to the current time whenever files are checked into the view. 

This property value is visible through the View Property dialog box in the StarTeam Cross-Platform Client, 

and is returned as part of the list-views query of the command line. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

Cloning Users 

You can now clone existing users to facilitate creating a new user based on another. In the User Manager, 

right click and select Clone. 
 

Custom Component Builder 

The Custom Component Builder now allows you to: 

• Clone a component definition to quickly create a new one based on another. 

• Export a definition to save a copy of it. 

• Read and display the XML file from other server configurations. 
 

Database Migration 

You can now use the database migration function to migrate PostgreSQL to Oracle or Microsoft SQL 

Server. 

Additionally, database migration is now supported on StarTeam Server running on Linux operating system. 
 

Import/Export Manager 

You can now use Import/Export Manager to copy data between Microsoft SQL Server and PostgreSQL. 
 

Online Purge 

Online Purge now supports PostgreSQL. 
 

Server Configuration Settings 

DefaultBinaryExtensions  This new setting in starteam-server-configs.xml allows you to specify 

a semi-colon separated list of extensions which will automatically be treated 

as binary files on check-in. 

 

Search 

The following are the new features for search: 

• You can select multiple configurations to search. 

• You can search using non-Windows Clients. 

• You can search using the StarTeam Web Client. 

• You can search users and groups in the User Manager. 
 

Shut Down Remote Server 

You can now use the Server Administration Utility to shut down remote server configurations. Click 

Actions > Shut Down Server. 
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15.1 
The following are the new features in this release. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

Select Command 

The Select command now contains new queries: 

connections-log  Reads and parses the server log, maps the connections to the user accounts, cross 

joins it to the available licenses and returns a table of all the results. 

merge-counts Produces output that counts the number of times a file has been merged from another 

view to this one. 

 

-locale Parameter 

For every command that takes a -pattern parameter, a -locale parameter is optionally available. This 

is the "two character country code". 
 

-netmon Parameter 

Use this option to capture the network traffic between the command line program and the StarTeam Server 

and write it in a file. 
 

StarTeam Web Server Command Support 

The following command line options are now available for the StarTeam Web Server: 

• Label Attach. 

• Label Detach. 

• JVM Parameter passing to the APE's launched by the StarTeam Web Server. 

 

StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

File Rollback 

The StarTeam Cross-Platform Client now supports a file rollback feature. The menu option is named Undo 

Revision, and when selected, the selected revision is used as the source, and the tip is used as the target 

to cause a reverse merge. Specifically, it removes the changes (introduced by that revision) from the tip. 

The resultant (reverse) merged content is written out to the working folders on disk, and you can check 

them in when ready. 
 

Multi-Configuration Search 

StarTeam allows users of the StarTeam Cross-Platform Client to search across multiple server 

configurations that may be running on different machines. Each UI provides the user an option to select 

from a list of available servers from which to search. Appropriate access rights checks are performed on all 

servers containing matching artifacts. 
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Federated Tracing 

The new Federated Tracing server configuration allows you to store all traces on a single federated server 

allowing clients easy access to the traces. Refer to Configuring Federated Tracing in the Installation Guide. 
 

Microsoft Edge 

Microsoft Edge is now supported. 
 

Microsoft Windows 10 

Microsoft Windows 10 is now supported. 
 

Skip a Revision in VCM 

View Compare/Merge now supports the ability to skip a selected revision of a source file when merging to 

the target. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

TLS/SSL Support for Email Notifications 

The StarTeam Server now provides TLS/SSL support for email notifications. Refer to Configuring Email 

Support and Email Notification in the StarTeam Server Help. 
 

TLS Support for Directory Service 

The StarTeam Server now provides TLS support for Directory Service. Refer to Configure Server Page 

(Directory Service Tab) in the StarTeam Server Help. 
 

Windows Authentication Support for SQL Server 

StarTeam Server now supports Windows Authentication support for SQL Server. Refer to Windows 

Authentication Support in the Installation Guide. 
 

64-bit SUSE Linux Support 

SUSE Linux 64-bit version is now supported. 
 

Import/Export Manager Supports PostgreSQL 

The Import/Export Manager now supports the PostgreSQL database. 
 

Multi-Configuration Search 

StarTeam allows users of the StarTeam Cross-Platform Client to search across multiple server 

configurations that may be running on different machines. Each UI provides the user an option to select 

from a list of available servers from which to search. Appropriate access rights checks are performed on all 

servers containing matching artifacts. 
 

Red Hat Enterprise Linux 6.7 

Red Hat Enterprise Linux 6.7 is now supported. 
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StarTeam Web Client 
The following are the new features for this release of the StarTeam Web Client. 

 

Changing Password 

The StarTeam Web Client now allows you to change your password from directly within the StarTeam Web 

Client. 

 

 

15.0 
The following are the new features in this release. 

 

All Components 
Search Locale Support 

Search is now supported for locales - English, Portugese, Chinese, Japanese, French and German. The 

indexing process picks up the locale of the machine to decide what analyzer to use. 

 

StarTeam Cross-Platform Client 

The following are the new features for this release of the StarTeam Cross-Platform Client. 
 

Report Directory Configuration 

You are now able to customize the directory where the reports are located by customizing the 

starteamcp file. 

 

Datamart 
The following are the new features for this release of Datamart. 

 

Sample Web Reports Support for Oracle 

The sample web reports introduced in the last release of Datamart now support Oracle. 

 

MPX 
The following are the new features for this release of the MPX components. 

 

ActiveMQ MPX 

This release introduces ActiveMQ MPX, based on Apache ActiveMQ technology, an updated messaging 

platform that can be used instead of StarTeamMPX (Tibco SmartSockets). The MPX and Cache Agent 

features have been updated with these supporting libraries which will be leveraged going forward to expand 

and improve upon the platform support of the StarTeam Server and its related components. This new 

technology will be the default messaging platform. 
 

  Important: We will continue to support the StarTeamMPX technology. However, server configurations 

can use one or the other, but not both, platforms. The Installation Guide and the MPX Administration 

Guides contain the full implementation details for this feature and what you may need to do. For more 
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information regarding Tibco SmartSockets end of support, please refer to https://support.tibco.com/ 

docs/TIBCOEndofSupportInformation.pdf. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

Checkout 

• Now supports the -pattern parameter. This allows a user to control the date keyword expansion 

format. 

• Now supports the -e parameter. This will throw an exception if -filter includes M, G, or U and any of 

the identified file statuses match Merge, Modified, or Unknown. The thrown exception will prevent all 

other files from being checked out as well. 
 

Detach-Label 

If a folder path is specified in -p, in conjunction with -all or -type, then only the items of the appropriate 

types in that folder path will be detached. Items not in that folder path will be retained. 
 

Label 

The label command now supports updating an existing label. 
 

List-Labels 

Now takes optional -d parameter. If specified, then a list of deleted labels will be generated. 
 

Select 

• Now takes an enhanced-links parameter. If specified, it generates an enhanced links report, which 

provides trace visibility across all views in the project for which trace the queried items shares exist. The 

columns identify revision details of all attached traces to the queried item. The rows identify the 

attached queried items. The report can span multiple items. 

• Now takes attached-labels parameter. This parameter produces a report combining all historical 

revisions of the selected item(s) with the labels attached to each of those revisions. The rows of this 

report match the label tab details in the client. 

• Now takes optional workspace parameter. Acts as a constraint on file queries. If specified, it locates 

not-in-view folders and files from the file system (the view path mapped to working folders on disk) and 

includes them in the report. 

• Now includes an unlabeled-revisions report that lists historical revisions of selected items that are 

unlabeled as of the last build. 
 

Starteamserver.exe 

-mb - This is a new optional parameter used when creating a new server configuration. Use the following 

values to set the type of message broker: 

• 0 = None 

• 1 = StarteamMPX 

• 2 = ActiveMQ MPX 

If this value is not specified, the new configuration is configured with ActiveMQ message broker. 

 

StarTeam Web Client 
The following are the new features for this release of the StarTeam Web Client. 

https://support.tibco.com/docs/TIBCOEndofSupportInformation.pdf
https://support.tibco.com/docs/TIBCOEndofSupportInformation.pdf
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Alternate Property Editor Support 

Alternate property editors (APE) created through StarFlow Extensions are now fully supported via the 

StarTeam Web Client. If APEs are enabled for the project, then the user will be shown the editor as a local 

dialog for updating with all workflow being fully enforced. When using APEs through the StarTeam Web 

Client, the APE will make a direct connection to the StarTeam Server and thus firewall settings between the 

user's machine and the StarTeam Server should be taken into consideration. 

 

 

14.4 
The following are the new features for version 14.4. 

 

All Components 

Search for PostgreSQL 

StarTeam now supports search for the PostgreSQL database. 

 

Datamart 
The following are the new features for this release of Datamart. 

 

Sample Web Reports 

Datamart now contains a set of sample web reports designed using BIRT (http://eclipse.org/birt/), an open 

source technology for data reporting. These reports can be viewed against any database configuration by 

using the Tomcat web server installed with StarTeam Server. 
 

Continuous Mode 

The continuous data extraction mode provides near real-time data reporting. This feature requires an MPX- 

enabled StarTeam Server for optimal performance. With this option, Datamart will run as a continuous 

process listening to events on the views/projects that have been selected for extraction and only queries 

the database when there is an update of interest on the server. 
 

PostgreSQL for Datamart 

Datamart now supports the PostgreSQL database. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

Add-Enum Command 

Use the add-enum command to add an enumerated value to an existing enumerated property of a type on 

the server. 
 

Add-Group Command 

Use the add-group command to add a group to the server. 

http://eclipse.org/birt/
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Add-Property Command 

Use the add-property command to add a property to an existing component the server. 
 

Add-Type Command 

Use the add-type command to add a type to the server. 
 

Add-User Command 

Use the add-user command to add a user to the StarTeam Server. 
 

List-Groups Command 

Use the list-groups command to list all of the groups in the server. 
 

List-Users Command 

Use the list-users command to list all of the users in the server. 
 

Merge-Label Command 

The merge-label command creates a new label (if it does not already exist) in the target view, copying 

the properties of the source label from the source view. 
 

Insert Command Parameters 

revisions Treats the contents in the file as a set of revisions of the same item. 

 

Select Command Parameters 

* An asterisk may be used as a wildcard targeted for expansion. This happens when 

a property name in the where clause identifies a text property, the relation is =, and 

the value starts with a "*". 

attached-to-label Specifies a label to which the items of the specified type have been attached. The 

items to be selected are the ones attached to the label. 

backlog The returned stories, constrained by conditions specified in the where clause, will 

only include stories without links to sprints. It excludes all stories related to sprints 

via traces. 

historical- 

revisions 

historical-revisions is a report that identifies and lists all the revisions at 

which the items are actually attached to the specified label. 

newline New lines inside text fields will be replaced by the provided separator. 

scopechange Generates a scope change report that is targeted at measuring the total scope 

(cost) of the sprint. 

toexcel Produces an output file which is in CSV format. 

 

StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 
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Rich Reports 

The StarTeam Cross-Platform Client offers Rich reports based on the BIRT report designer to create 

custom reports. You can easily select your data source and tables and fields from the StarTeam schema to 

customize your report. 

  Note: The Rich reports are not localized in this release. They are only available in English. 

StarTeam Eclipse Plugin 
The following are the new features for this release of the StarTeam Eclipse Plugin. 

 

Windows 8 

This version now supports Windows 8. 
 

Eclipse Version 4.3 

This version now supports Eclipse 4.3. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

Custom Component Builder 

StarTeam Server's Custom Component Builder is used to create custom components analogous with 

StarTeam's own internal components, such as the File, Change Request, Task, or Topic. The Custom 

Component Builder in the StarTeam Server walks you through creating the component, its properties and 

values and finally, deploying your component in a single click. 

 

StarTeam Visual Studio Plugin 
The following are the new features for this release of the StarTeam Visual Studio Plugin. 

 

Windows 8 

This version now supports Windows 8. 
 

Visual Studio 2013 

This version now supports Visual Studio 2013. 
 

 

14.3 
The following are the new features for version 14.3. 

 

All Components 

Search 

StarTeam allows full text search on all server-wide artifacts. Search components are installed as part of 

StarTeam Server. 
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After the search components are configured on the StarTeam Server, you can use search in many 

StarTeam clients. 
 

  Note: Search only works for the English locale. Support for other locales will be introduced in future 

releases. 

  Note: Search is available for: 

• The StarTeam Web Client. 

• The StarTeam Cross-Platform Client on Microsoft Windows. 

 

StarTeam Command Line Tools 
The following are the updates for this release of the StarTeam Command Line Tools. 

 

Move Command 

Use the move command to move StarTeam items. You can use this command to move all item types: 

Folder, File, Change request, Task, Topic, Requirement, Sprint, Story, Concept, WhiteBoard, and custom 

components. 
 

Trace Command 

A trace is a link between any two StarTeam items. It expresses a join relationship. Use the trace 

command to create or to find and update a trace in a project/view described by the -p parameter (or 

preceding connect/set commands). A trace will only be created if its endpoints are guaranteed to exist. 
 

Command Line Parameters 

The following commands have new parameters: 

apply-label 

command 

Use the -folder parameter with the apply-label command to apply labels to 

specified folders. 

select command 
workrecords Use the workrecords parameter with the select 

command to select Tasks. 

links and changes   Use these parameters with the select command to create 

reports on all item types. 
 
 

StarTeam Cross-Platform Client 
The following are the new features for this release of the StarTeam Cross-Platform Client. 

 

Plugin for Jenkins CI 

The plugin for Jenkins CI has been updated to use the latest APIs and to address bugs and performance 

issues. Look for the new version 1.0+ available from the plugin manager within your own Jenkins 

installation or contact your Micro Focus support representative. More details available on the Jenkins- 

StarTeam wiki: https://wiki.jenkins-ci.org/display/JENKINS/StarTeam. 
 

History and Log Keywords 

StarTeam supports Log and History Keywords from the StarTeam Server and from the MPX Cache Agent. 

https://wiki.jenkins-ci.org/display/JENKINS/StarTeam
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SendTo Email 

The SendTo email feature now supports specifying recipients by typing user names as well as selecting 

them using a list. This allows you to copy and paste long lists of recipients into the StarTeam Cross- 

Platform Client. 
 

DateTime Grouping 

Grouping by the DateTime property is now supported such that the month, day, and year are used for 

grouping and time of day is ignored. 
 

Project Specific Filters 

The StarTeam Cross-Platform Client now supports the ability to create and use project-specific filters. 

 

StarTeam Server 
The following are the new features for this release of the StarTeam Server. 

 

PostgreSQL Database Support 

In addition to Oracle and Microsoft SQL Server, StarTeam Server now supports PostgreSQL as a 

database. Refer to the StarTeam Installation Guide for more information. 
 

Import/Export Manager Support for Oracle 

This version of the Import/Export Manager supports Oracle. 

 

StarTeam Web Client 
The following are the new features for this release of the StarTeam Web Client. 

 

Opening Items in the StarTeam Cross-Platform Client 

The StarTeam Web Client can now open items in the StarTeam Cross-Platform Client. 

 

TeamInspector 
The following are the new features for this release of TeamInspector. 

 

64-bit TeamInspector 

TeamInspector is now available and compiled as a 64-bit application. 
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System Requirements 

This section contains system requirements for StarTeam components. 
 

 

StarTeam Cross-Platform Client System Requirements 
The StarTeam Cross-Platform Client is implemented in Java and can be installed on Microsoft Windows 

and any system that supports the Zulu OpenJDK 1.8.0_192. The StarTeam Cross- Platform Client has 

been tested on the following systems with the noted hardware and software: 

 
Software 

Operating Systems (32- and 64-bit) • Microsoft Windows 10 

• Microsoft Windows 8 

• Microsoft Windows 7 

• Microsoft Windows XP Professional SP3 

• Microsoft Windows Vista SP1 

• RedHat Enterprise Linux 6 & 7.3 

• Ubuntu 14.04 

• SUSE 11.3 

• Mac: El Capitan, Yosemite. 
 

Adobe Acrobat For viewing the PDF manuals 

Web browser (for online help) • Internet Explorer 8 or later (Microsoft Windows only) 

• Firefox 4 or later 
 
 

Hardware 

Processor 32-bit dual core 

RAM 2 GB minimum 

Hard disk space  200 MB to install the application. Also, sufficient disk space is required for your working 

files. The amount will vary depending on your use of the product. 

Display 
Required SVGA, high color mode, 1024x768 

Recommended 1280x1024 or more 
 

Mac Models • MacBook (Early 2015). 

• MacBook (Late 2008 Aluminum, or Early 2009 or newer). 

• MacBook Pro (Mid/Late 2007 or newer). 

• MacBook Air (Late 2008 or newer). 

• Mac mini (Early 2009 or newer). 

• iMac (Mid 2007 or newer). 

• Mac Pro (Early 2008 or newer). 
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• Xserve (Early 2009). 

 
  Note: Support is for physical Apple computers. OS X Virtual Machines are not supported. 

 
Datamart System Requirements 

The following are the system requirements for installing and running this release of Datamart. 

Operating 

Systems 

 
• Microsoft Windows Server 2016 

• Microsoft Windows Server 2012 

• Microsoft Windows Server 2008 R2 (64-bit) 
 

Databases • Microsoft SQL Server 2016 

• Microsoft SQL Server 2012 

• Microsoft SQL Server 2008 R2 

• Oracle 12.2 

• Oracle 11g R2 

• Oracle 11g, version 11.1.0.6.0 

• Oracle 10g R2, version 10.2.0.4.0 

• PostgreSQL 9.6 

• PostgreSQL 9.3  

   Note: For database system requirements, refer to the database vendor guidelines. 

JDBC Drivers   It is necessary to download and install the native JDBC drivers for your databases on the 

computer that hosts the Datamart Extractor. The native drivers provide greater 

performance than other re-distributable drivers and include support for double-byte 

characters. You can download these drivers for free at the web site for the appropriate 

vendor: 

Microsoft SQL Server   Download at http://msdn.microsoft.com/en-us/data/ 

aa937724.aspx 

Oracle Download at http://www.oracle.com/technology/software/tech/ 

java/sqlj_jdbc/index.html 

PostgreSQL Download at https://jdbc.postgresql.org/download.html 
 

Processor • 600-MHz Pentium III-class processor or greater 

• 600-MHz Sun SPARC/UltraSPARC 
 

RAM • 512 MB minimum 

• 1 GB or more recommended 
 

Optional 

reporting 

software 

• Business Objects 6.5, XI, and XIR2 or higher (required when using Datamart 

Synchronizer) 

• Crystal Reports 10 or higher 

http://www.microsoft.com/sql/downloads/2000/default.mspx
http://www.microsoft.com/sql/downloads/2000/default.mspx
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html
https://jdbc.postgresql.org/download.html
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Hard disk 

space 

100 MB available disk space for application and installation 

 

  Note: The Datamart Extractorbenefits from hardware that provides faster data write speeds such as 

high RPM hard drives. 
 
 

StarTeam Eclipse Plugin System Requirements 
The following are the system requirements for running the StarTeam Eclipse Plugin. 

 
  Important: For the StarTeam Eclipse Plugin, we recommend the use of a 1.6+ JRE. The latest JRE 

can be downloaded at http://www.oracle.com/technetwork/java/javase/downloads/index.html. To 

specify the use of the JRE when launching Eclipse, place the -vm command line argument at the 

beginning of the eclipse.ini file (example: -vm C:\jre1.6.0_29\bin\javaw.exe). 

Eclipse Versions 4.4 and above 

Java Versions 1.6 and above 

Operating Systems • Microsoft Windows 8 

• Microsoft Windows 7 (32-bit and 64-bit) 

• Microsoft Windows XP Professional SP3 (32-bit and 64-bit) 

• Microsoft Windows Vista Business SP2 (32-bit and 64-bit) 

• Solaris 10 (32-bit) 

• Red Hat Enterprise Linux 5.5 (32-bit) 

• Ubuntu 14.04 
 

StarTeam Server 

Versions 

Product 

Interoperability 

2009 and above 
 
 

• This release of the StarTeam Eclipse Plugin was tested with Rational 

Application Developer 7.5, and JBuilder 2008 R2. While the tests were 

limited, no problems in using this version of the StarTeam Eclipse Plugin 

with any of these products have been found. 
 

Hard Disk Space In addition to the space required for Eclipse, hard disk space of 37 MB to install 

the application. 
 

   Note: Sufficient disk space is required for your working files. The amount 

will vary depending on your use of the product. 

 
  Note: It is strongly recommended that the Java memory allocation heap be increased when using this 

product. This setting is specified using the Java commands (-vmargs) -Xms and Xmx. Determining 

the proper settings will depend on the amount of physical memory available. Significant performance 

improvement will be recognized by utilizing greater amounts of memory. However, large heaps should 

be avoided if there is insufficient physical memory to avoid paging. For additional information 

regarding memory heap settings please refer to Eclipse.org, IBM.com and Java.Sun.com. 

If a previous version of this product is installed on the target computer it should be uninstalled or 

disabled prior to installing this version. 

 

 

StarTeam Layout Designer System Requirements 
The Layout Designer can be installed on Microsoft Windows systems that support the Oracle JRE 

1.8.0_112. The system requirements are listed below: 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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Software 

Operating Systems (32-bit) • Microsoft Windows 8 

• Microsoft Windows XP Professional SP3 

• Microsoft Windows Vista SP1 

• Red Hat Enterprise Linux (WS) 5.1 
 
 

Hardware 

Processor 32-bit dual core 

RAM 2 GB minimum 

Hard disk space  200 MB to install the application. Also, sufficient disk space is required for your working 

files. The amount will vary depending on your use of the product. 

Display 
Required SVGA, high color mode, 1024x768 

Recommended 1280x1024 or more 
 

Mac Models • MacBook (Early 2015). 

• MacBook (Late 2008 Aluminum, or Early 2009 or newer). 

• MacBook Pro (Mid/Late 2007 or newer). 

• MacBook Air (Late 2008 or newer). 

• Mac mini (Early 2009 or newer). 

• iMac (Mid 2007 or newer). 

• Mac Pro (Early 2008 or newer). 

• Xserve (Early 2009). 

 
  Note: Support is for physical Apple computers. OS X Virtual Machines are not supported. 

 
MPX System Requirements 

  Important: Prior to installing, please read the appropriate MPX Administrator's Guide and the 
StarTeam Installation Guide on the Product Documentation page of the Micro Focus web site at 
http://supportline.microfocus.com/productdoc.aspx. Proper planning is required in order to achieve 

best results from MPX. 

The StarTeam Server must be installed prior to installing the Message Broker and MPX Cache Agent. MPX 

transmitters have the same system requirements as the StarTeam Server because they are part of that 

system. The MPX Message Broker is required - it can be the ActiveMQ MPX Message Broker or the 

StarTeamMPX Message Broker.The MPX Message Broker is a publish/subscribe messaging engine that 

broadcasts messages to subscriber components on a topic basis. It is a stand-alone process that can run 

on a separate computer to offload network processing overhead in high-volume environments. For details, 

see the StarTeam Server System Requirements in this document. You can also set up MPX Cache Agents 

in tiers at a variety of locations so that file contents and objects, transmitted by the file transmitter, can be a 

local network near any StarTeam user.MPX Cache Agents work with the StarTeam Cross-Platform Client to 

check out files and fetch objects faster. 

 
Message Brokers and MPX Cache Agent 

 

  Note: For the MPX Cache Agent, these requirements should be sufficient for teams that have 50 to 

100 members. 

http://supportline.microfocus.com/productdoc.aspx
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Operating 

Systems 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Processor/ 

Hardware 

• Microsoft Windows Server 2008 R2 (64-bit) 

• Red Hat Enterprise Linux 6.7 (64-bit) 

• SUSE Linux 11.3 and 11.4 (64-bit) 
 

   Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit 

Windows system. The installer will return an error. 
 

   Note: StarTeam Server 16.3 and above support IP V6. The MPX Message Broker 

( Technology built on Smart Sockets) does not support IP V6 networks. 

Customers who intend to be on IP V6 networks should migrate to ActiveMQ MPX 

Message Brokers. 

 
• Disk appropriate for size of cache; fast disk preferable but not mandatory 

• 100 Megabit NIC or better 

• 1 CPU P4 1Ghz or better 

 

RAM 256 MB memory or better 

   Note: A MPX Cache Agent supports memory caching, which is important if 

object caching is enabled. Therefore, additional memory should be available to 

support the desired amount of memory caching. The default memory cache size 

is 100MB. 
 

Hard disk 

space 

12 MB to install the application plus sufficient disk space for the desired size of each 

MPX Cache Agent's cache 

Display SVGA, high color mode, 1024x768 or greater 

Recommended resolution: 1280x1024 or more 

Other Adobe Acrobat Reader for viewing the MPX Administrator's Guide 
 

Hardware Recommendations 

The following are the recommended system configurations according to the number of peak users: 

Less than 100 64-bit, dual-core systems with 4GB of memory 

100-200 64-bit, quad-core systems with 4-8GB of memory 

More than 200 64-bit, quad-core systems with 8-16GB of memory 

For the Message Broker, the number of peak users is typically lower than the number of peak users 

connected to the StarTeam Server since multiple Message Brokers are used in medium-to-large 

deployments. The number of peak users connected to a MPX Cache Agent is significantly lower because 

MPX Cache Agents are only used in short bursts. As a result, less hardware resources are typically 

required to support the Message Broker and MPX Cache Agent compared to the StarTeam Server. 

Moreover, for a given geographic location, the Message Broker and MPX Cache Agent are typically 

deployed on the same machine. 
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StarTeam Quality Center Synchronizer System 

Requirements 
StarTeam Quality Center Synchronizer has been tested on Microsoft Windows Server 2003 SP2 (32-bit 

version) and Microsoft Windows Server 2008 R2. It is recommended that you install the Synchronizer on 

the same computer on which the Synchronizer for Quality Center database resides, unless that is not a 

Microsoft Windows platform. Because of the OTA APIs, the Synchronizer must run on a Microsoft Windows 

operating system. It has no unusual operating system requirements. 

• The Enterprise or Enterprise Advantage edition of the StarTeam Server for Microsoft Windows 15.0. 

• Quality Center 9.0, 9,2, 10.0, 11.0, and 12.5. 

• A Java Runtime Environment (JRE), version 1.8.0_112 or later. 

The software listed above does not need to be located on the same machine as the Synchronizer, which 

can, if desired, run on a separate machine. However, the Synchronizer must have network access to the 

Synchronizer for Quality Center database and the StarTeam Server. 

 

 

StarTeam Server System Requirements 
We recommend installing the StarTeam Server on a dedicated application server and installing the 

database on a separate server unless you are using a supported version of Microsoft SQL Server Express 

as your database. 
 

  Important: You must uninstall the previous version before installing the current version of the 

software. You should also delete the following folders if they exist: 
 

 

There should be a dedicated connection between the computers running the StarTeam Server and the 

database management system. For optimal performance, both machines should be on the same physical 

switch. 

The following shows the minimum and recommended hardware for the computer on which you deploy the 

Server application and database. Although specific processor speeds are listed, you should always use the 

fastest available CPU to maximum performance. 

  Note: The StarTeam Cross-Platform Client only supports StarTeam Server versions 12.0+. 

  Important: If you are upgrading from a previous version of StarTeam Server, you must review the 

upgrade instructions in the StarTeam Installation Guide. There are some steps that you must 

complete in order for the upgrade to complete successfully. Failure to complete these steps can cause 

the upgrade to fail. 

 

Operating Systems 
• Microsoft Windows Server 2016 

• Microsoft Windows Server 2012 R2 (64-bit) 

• Microsoft Windows Server 2012 (64-bit) 

<Server Installation folder>\<Apache Webserver Installation Folder>\webapps 

\search 

<Server Installation folder>\<Apache Webserver Installation Folder>\apache- 

tomcat-[version]\webapps\ConnectWeb 

<Server Installation folder>\<Apache Webserver Installation Folder>\webapps 

\borland 
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• Microsoft Windows Server 2008 R2 (64-bit) 

• Red Hat Enterprise Linux 6.7 (64-bit) 

• SUSE Linux 11.3 and 11.4 (64-bit) 

 
StarTeam Server for 64-bit Microsoft Windows Operating Systems 

The minimum memory requirement for StarTeam Server and ActiveMQ MPX Message Broker is 8 GB 

without the database engine installed on same server. The minimum requirement for StarTeam Server with 

ActiveMQ MPX Message Broker and database engine installed on the same computer is 16 GB. 

 

Databases 

StarTeam Server supports both 32-bit and 64-bit databases. The following databases have been tested 

and are supported: 

• Microsoft SQL Server 2016 

• Microsoft SQL Server 2014 

• Microsoft SQL Server 2012  

• Microsoft SQL Server 2008  

• Oracle Database 12c version 12.2 

• Oracle Database 12c version 12.1.0.2.0 

• Oracle Database 11g R2 

• PostgreSQL 9.6 

• PostgreSQL 9.3 
 

  Note: You can install PostgreSQL as part of the StarTeam Server installation. You must purchase the 

other database products from the appropriate vendor. Refer to the StarTeam Installation Guide for 

more information about recommended system configurations for running StarTeam and your database 

on the same computer and for running StarTeam Server and its associated database on separate 

computers. 
 

  Important: Never modify database contents or vault files other than through the StarTeam client or 

the Server Administration Tool. Direct database manipulation is unsupported. 

 
Database User and Password 

The PostgreSQL database server installed by default with StarTeam Server has two default users created: 

• Admin user = postgres 

• Superuser = Borland_Login 

The password for both is Borland_123. 

When you use the default PostgreSQL database, you will be asked for a System Password. It is the same 

as the Admin user password, Borland_123. 

 

Web Browsers 
• Internet Explorer 8 or later 

• Firefox 4 or later 
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Third Party Software 
Please ensure these other software requirements are met: 

 
JRE 

The StarTeam Server uses the Zulu OpenJDK 1.8.0_192 which is automatically installed at C:\Program 

Files\Micro Focus\StarTeam Server <version>\jre. 

 

Adobe Acrobat 

Required for viewing the documentation in PDF format. 

 
Virus Scanning Utilities 

Every StarTeam Server computer should be equipped with a virus protection utility that has up-to-date 

virus definition files. All StarTeam Servers should also be equipped with up-to-date virus protection and the 

settings should be set to alert only the administrator. The StarTeam administrator should halt the StarTeam 

Server immediately upon virus detection, perform a full backup, and then follow the instructions provided by 

the virus protection vendor for cleaning the virus from the infected file. If the infected file cannot be cleaned 

or if problems exist, contact http://supportline.microfocus.com before restarting the StarTeam Server. Some 

viruses can be immediately destructive to the repository and in rare cases data loss will be inevitable. We 

strongly recommend that you perform regular backups. 

A virus that might be a nuisance to a file system can be far more destructive when checked into the 

repository. For example, many virus protection utilities are set by default or can be set to delete infected 

files. If an archive file is deleted by the virus protection utility, data may be lost. 

Another example is that a virus may not be detected in the archive and may sit dormant waiting to infect the 

computers of all project users. Your network will rapidly spread the virus and a data loss could occur. 
 

  Note: If any process or program such as anti-virus software alters files under StarTeam control the 

system could behave erratically. It is highly recommended that these processes not be allowed to 

modify system or data files under StarTeam control. 

 

StarTeam Server and Microsoft SQL Server Express on 

the Same Computer 
When Microsoft SQL Server Express is used, the database typically resides on the same computer as the 

corresponding StarTeam Server application. The following hardware recommendations for a joint StarTeam 

Server/Microsoft SQL Server Express computer are based on the number of seats (registered users). 

However, your situation might vary depending on the size of your StarTeam projects and the number of 

projects managed by the StarTeam Server configuration. 

The following lists suggested system configuration requirements if you are using Microsoft SQL Server 

Express and the StarTeam Server on the same computer: 

Less than 50 Seats 64-bit dual core machine with 4 GB of RAM 

50-100 Seats 64-bit quad core machine with 4-8 GB of RAM 

 
  Note: Microsoft SQL Server Express is not recommended for configurations serving more than 100 

registered users. 

 

StarTeam Server and Database on Different Computers 
The following hardware recommendations apply when the StarTeam Server application is executing on a 

different computer than the database server. They are based on the number of peak users (maximum 

http://supportline.microfocus.com/
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concurrent users during peak periods). However, your situation might vary depending on the size of your 

StarTeam projects and the number of projects managed by the server configuration. 

 
Number of Peak Users 

Less than 100 64-bit, dual-core systems with 4 GB of memory 

100 - 200 64-bit, quad-core systems with 4-8 GB of memory 

More than 200 64-bit, quad-core systems with 8-16 GB of memory 

 

Database Server System Requirements 
The following recommendations apply to the database server when it is not on the same computer as the 

StarTeam Server. The number of peak users is the maximum number of concurrent users during peak 

usage periods. 

 
Number of Peak Users 

Less than 100  Computer with a dual core processor and 4 GB of RAM 

100-200 
Minimum Computer with quad processors and 4 GB of RAM 

Recommended Minimum configuration plus RAID system 
 

More than 200   
Minimum Any high-performance Enterprise Server with quad processors and 

4-8 GB of RAM 

Recommended   Minimum configuration plus RAID system 
 
 

Unicode Character Sets 
While StarTeam Server supports data in all languages that can be encoded in UTF-8, it only uses ASCII 

characters (0-127) as it expands keywords. Keyword expansion and EOL conversion should work for all 

“ASCII-based” encodings, which include UTF-8, Cp1252, and so on. For the various UTF-16 encodings, 

StarTeam Server currently performs EOL conversion, but does not expand keywords. 

The internal names of custom fields must be ASCII, but the display names can be in non-English character 

sets. 

 

System Requirements for Linux 
• Linux Suse 11.3 and 11.4 (64-bit) 

• Zulu OpenJDK1.8.0_192+ 

• Oracle Client 11g R2 

• PostgreSQL version 9.3 

  Note: The Oracle database does not have to reside on the same machine as the StarTeam Server. 

 
StarTeam Visual Studio Plugin System Requirements 

The StarTeam Visual Studio Plugin should run on any platform on which Microsoft Visual Studio 2012, 

2013, 2015, or 2017 is supported. 

This integration was tested with the following: 
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Platforms • Microsoft Windows 10 

• Microsoft Windows 8 

• Microsoft Windows 7 

• Microsoft Windows Vista Business SP1 

• Microsoft Windows XP SP3 (32-bit versions) 
 

Microsoft Visual Studio • Microsoft Visual Studio 2017 Professional and Standard Editions 

• Microsoft Visual Studio 2015 Professional and Standard Editions 

• Microsoft Visual Studio 2013 Professional and Standard Editions 

• Microsoft Visual Studio 2012 Professional and Standard Editions 

StarTeam Server 16.1 
 

 

StarTeam Web Client System Requirements 

Web Browsers 

• Microsoft Edge 

• Internet Explorer 9 or later 

• Firefox 4 on Microsoft Windows and Linux 

• Chrome 
 

 

StarTeam Web Server System Requirements 

Operating 

Systems 

 
• Microsoft Windows Server 2016 

• Microsoft Windows Server 2012 R2 (64-bit) 

• Microsoft Windows Server 2012 

• Microsoft Windows Server 2008 R2 SP1 (64-bit) 
 

Hardware 
Processor 64-bit quad core 

RAM 8 GB minimum 

Hard disk space 200 MB to install the application 
 

Software Java and Tomcat are installed with the installation package. 

 
  Note: You cannot install a 64-bit Microsoft Windows StarTeam component on a 32-bit Microsoft 

Windows system. The installer will return an error. 
 

 

StarTeam Workflow Extensions System Requirements 

Extensions and the 

Workflow Designer 

They have the same system requirements as the StarTeam Cross-Platform 

Client. 

Notification Agent Has the same system requirements as the StarTeam Server. 

We recommend installing the StarTeam Server prior to installing the StarTeam 

Notification Agent. 
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TeamInspector System Requirements 
TeamInspector provides a release readiness and build quality management system through the following 

features: 

• Build and test automation environment with flexible continuous integration options 

• Comprehensive monitoring of build, test, and code analysis results through a dashboard 

• A portfolio view that presents relevant current and trending data for projects 

• Email and SMS message alerts of build events 

• Support for heterogeneous build environments 

• Built-in support for commonly used tools and SCM systems 

• OpenInspector™ framework enables user-defined inspectors to support open-source tools, third-party 

tools, and user-defined tools 

• Support for distributed builds and dependent builds 

The following are its system requirements: 

Processor • Dual Processor 3 GHz 

• Dual Intel Xeon 5000 Quad-core (recommended) 
 

RAM • 4 GB system memory 

• 16 GB system memory (recommended) 
 

Hard disk space • 100 GB of available space 

• 750 GB of available space (recommended for large enterprise 

environments) 
 

Operating System • Microsoft Windows Server 2012 

• Microsoft Windows Server 2008 

• Microsoft Windows Server 2003 

• RedHat Linux 4.x 
 

Web Browsers • Mozilla Firefox 3.x 

• Internet Explorer 7.x 
 

Build Tools • Apache Ant 1.7.x (the JAVA_HOME system environment variable must 

point to the JDK 1.5 or later) 

• NAnt 0.85 

• Any tool that can be encapsulated inside a NAnt or Ant script 

• Command-line builders 
 

Source Control System • StarTeam 2006, 2008, with the StarTeam SDK 10.0 or later 

• Subversion 1.5.x, with the SVNKit 1.2.3 

• Perforce 2008.1, with the command line client (P4) 

• IBM Rational ClearCase 7.1, with the ClearCase Remote Client 
 

Versions Supported for 

Standard Inspectors 

(test/analyzer tools) 

• JUnit 4.5 

• NUnit 2.4.x 

• Checkstyle 4.4 

• Emma 2.0.5312 
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Supported 

OpenInspectors 

• Silk Central Test Manager 2008 or later 

 
• Code-analysis tools that output to XML format 

• Unit-test tools that output to XML format 

• Code-coverage tools that output to XML format 
 
 

StarTeam Microsoft SCC Integration Requirements 
Following are the system requirements for installing and running the integration. 

  Note: This release of the integration is built with and supports Java version 1.6.0_02. 

Platforms • Microsoft Windows 10 

• Microsoft Windows 8 

• Microsoft Windows 7 

• Microsoft Windows XP Professional SP3 

• Microsoft Windows Vista SP1 
 

SCC Third- 

Party Products 
The integration works with various third-party products that use the Microsoft SCC API. 

This API enables you to perform version control operations, such as checking files in 

and out, using StarTeam as the SCC provider. 
 

StarTeam Server 2009 and above 

StarTeam Cross- 

Platform Client 

(optional) 

 

2009 and above 
 

   Note: You do not need to install the StarTeam Cross-Platform Client on the 

workstation running the integration. However, the integration does not 

provide a way for you to change any StarTeam personal options or 

StarTeam project properties. Pre-existing settings for the StarTeam projects 

that you are accessing using the integration remain in effect. 

 
 

Hardware 

Processor 32-bit dual core 

RAM 2 GB minimum 
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Known Issues 

The following sections contain the known issues for this release. 
 

 

Documentation Known Issues 

StarTeam Server Help 

Help content when viewed using Internet Explorer 10 does not display correctly. This issue can be resolved 

by setting the browser Compatibility Mode to Internet Explorer 9 in the Developer Tools (F12) 

preferences of Internet Explorer 10. 

 
Eclipse Infocenter 

When you open the first instance of a StarTeam application, such as the StarTeam Cross-Platform Client , 

and click on the Help Topics menu, the Eclipse Infocenter opens and displays the correct help contents for 

that application. However, when you close the application, and/or open another StarTeam application, such 

as the Server Administration tool , when you click on the Help menu, the Eclipse Infocenter displays the 

help from the previous application, in this case, the StarTeam Cross-Platform Client. The workaround for 

this is to go into the installation directory of the first application in which you clicked Help (StarTeam Cross- 

Platform Client in this example), and in the \help subfolder, double-click shutdown.bat. This releases 

the previous applications Help contents from memory so the correct help will display when you open it in 

the second application. 

 

 

StarTeam Command Line Known Issues 

stcmd Path 

Specifications 

 

stcmd path specifications must use Java conventions (not Microsoft Windows). For 

example, the following will throw an IndexOutOfBounds exception: 

 

 
 

The following will work correctly on all platforms that support the java virtual machine 

(Microsoft Windows, Unix, and Mac): 
 

 
 

Quoted 

Argument with 

a Space 

When specifying a quoted argument that contains a space, the beginning quote must 

be preceded by a space. The following are examples of both incorrect and correct 

syntax for arguments with spaces: 

Incorrect: stcmd set project="StarFlow Extensions" 

Correct: stcmd set project = "StarFlow Extensions" 

Incorrect: stcmd select name from File where query="Flagged Items" 

Correct: stcmd select name from File where query = "Flagged Items" 

stcmd co -rp "c:\temp" -p 

"Administrator:Administrator@localhost:49201/StarDraw/ 
StarDraw" * 

stcmd co -rp "c:/temp" -p 

"Administrator:Administrator@localhost:49201/StarDraw/ 
StarDraw" * 
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StarTeam Cross-Platform Client Known Issues 

 
• 32 bit version of CPC does not support Search and Code Review perspectives  
• On SUSE 11.3, Cross Platform Client could fail to load a view with  error – “reported GLX version = 1.2 GLX version 

1.3 or higher is required”. Upgrading glibc package on that machine to 2.14 or higher should resolve the issue. 

• The StarTeam Cross-Platform Client no longer installs the StarTeam SDK separately. It installs the 

StarTeam SDK .jars in place as part of the StarTeam Cross-Platform Client installation. This means 

that older version of 16.x SDKs will continue to reside on machines and stcmd or custom scripts will 

continue to use these older versions. 

If using stcmdEx, please note that the stcmdEx.jar is also installed as part of the StarTeam Cross- 

Platform Client installation. The StarTeam SDK installer is not necessary when using stateless 

commands via this utility. 

If using stcmd, you must install the StarTeam SDK directly. The StarTeam SDK installer is available for 

download as a separate install. If you need help uninstalling older versions of the StarTeam SDK or the 

StarTeam Cross-Platform Client, contact Micro Focus support for a clean up utility. 

• On a Mac, PDFs installed within StarTeamAdmin application folder will not open because of 

permissions restrictions. The same files can be accessed from StarTeamCPC application folder. 

• You cannot open the web help directly from the product on a Mac. Use Finder to navigate to the 

installation directory and open up the PDF version of the help. 

• The external File Compare Merge tool is not included with the StarTeam Cross-Platform Client on Mac. 

However, you can still use the embedded File Compare Merge. 

• The spell checker does not work when running on Mac. 

• If you receive the error, Unable to watch file system path... when running the StarTeam 

Cross-Platform Client, do the following: Click Tools > Personal Options, and turn off the Enable File 

System Watching option. Then, shutdown and restart the StarTeam Cross-Platform Client. This will 

resolve the problem. 

• Enabling the BIRT Report Editor in Eclipse: 

1. Download the Eclipse plus BIRT bundle from https://www.eclipse.org/downloads/packages/eclipse- 

ide-java-and-report-developers/lunasr2. 

2. Install the bundle on your Linux system. 

3. Add the three BIRT plugins to the Plugins folder of Eclipse. For example, cp <cpc install 
dir>/lib/org.eclipse.birt.report.data.oda.starteam*.jar <eclipse dir>/ 

plugins. 

4. Set the ST_BIRT_HOME environment variable to point to the Eclipse binary. For example, in 

your .profile (or however environment variables are set in the users linux distro) add: 

export ST_BIRT_HOME=/<eclipse install dir>/eclipse. 

• The StarTeam Cross-Platform Client is localized to run natively in English, German, French, 

Portuguese, Chinese and Japanese, on those respective platforms. 

However, for users on platforms other than the six described above, or for users who wish to specifically 

run the StarTeam Cross-Platform Client in a different locale from the native platform, the system 

property -Duser.language can be specified on the options entry in the StarTeamCP.stjava{32| 

64} file. 

• For Japanese, specify -Duser.language=ja. 

• For Chinese, specify -Duser.language=zh. 

• For Portuguese, specify -Duser.language=pt. 

• For German, specify -Duser.language=de. 

• For French, specify -Duser.language=fr. 

• For English, specify -Duser.language=en. 

https://www.eclipse.org/downloads/packages/eclipse-ide-java-and-report-developers/lunasr2
https://www.eclipse.org/downloads/packages/eclipse-ide-java-and-report-developers/lunasr2
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• Micro Focus recommends that you shut down all other applications when installing StarTeam 

components because other applications can cause the installer to hang. Shutting down all applications 

resolves such issues during installation. 

• On a Microsoft Windows 7 platform, the Help is only available in PDF version. Access the help from the 

Start menu or from the pdf subfolder in the client installation folder. For example, C:\Program Files 

\Micro Focus\StarTeam Cross-Platform Client Client <version>\PDF. 

• On Microsoft Windows XP SP3, opening Help (Help > Help Topics) requires you to change your 

Internet Explorer security setting to view the Help. As a workaround, follow the steps below: 

1. Open Internet Explorer. 

2. Select Tools > Internet Options. 

3. Select the Advanced tab. 

4. Scroll down to the Security options. 

5. Select the option to Allow active content to run in files on My Computer. 

• When running the StarTeam Cross-Platform Client with 'User Account Control' turned on, you may 

experience some security warnings regarding local files that are not accessible. Launching the 

StarTeam Cross-Platform Client for the first time, and initializing the log with help launched, are two 

examples where you will experience the security issue. 
 

  Note: If a security warnings does appear, it will not prevent you from working normally in 

StarTeam. 
 

 

StarTeam Eclipse Plugin Known Issues 
• StarTeam Eclipse Plugin does not work with the default Firefox shipped with Solaris 11, which is 

located in /usr/lib/firefox due to a missing library in that release. To fix the issue: 

1. Download Mozilla 1.7 from http://ftp.mozilla.org/pub/mozilla.org/mozilla/releases/mozilla1.7.13/ 

contrib/mozilla-1.7.13-sparc-sun-solaris2.8-gtk2.tar.bz2. 

2. Extract it to a user accessible path accessible such as the user home at /export/home/user/ 

mozilla. 

3. Add the following variables to the user profile file in ~/.profile 

• export MOZILLA_FIVE_HOME=/export/home/user/mozilla 

• export LD_LIBRARY_PATH=$MOZILLA_FIVE_HOME:$LD_LIBRARY_PATH 

4. Log out and log back in to pick up the environment variables that you added. 

• If the folder C:\Users\<username>\AppData\Borland\StarTeam does not exist, servers are not 

saved. 

This occurs on clean environments, specifically those where no StarTeam products have been installed. 

To correct this, change the StarTeam Preferences from Eclipse. Changing the preferences creates the 

folder. 

• You cannot view the properties of a change package in the Change view in the StarTeam Eclipse 

Plugin, but you can view this information in the Change tab in the StarTeam Cross-Platform Client . 

• When using the StarTeam Eclipse Plugin along with the Tasktop Dev plug-in for StarTeam, the 

preferences for Team > StarTeam > Synchronize should all be turned off since the Tasktop Dev plug- 

in will handle the synchronization capabilities. The preferences for Team > StarTeam > Synchronize 

have all been turned off by default now as well. 

• The StarTeam Eclipse Plugin does not support the ability to perform a check out and merge action. You 

will receive a message that an internal error occurred if you try this option. 

• In Eclipse 4.2, if you close Eclipse while an embedded item editor is open, an error occurs when you 

reopen Eclipse as it attempts to reopen the editor document window. You will need to close the 

document window and reopen the item in the StarTeam Classic view. 

• Checkout of a linked file from the Link view does not check out the revision linked, instead it checks out 

the tip revision of the linked file. 

http://ftp.mozilla.org/pub/mozilla.org/mozilla/releases/mozilla1.7.13/
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• To check out a missing file, you cannot use an item view pane, you must use the Synchronize view. 

• The Error Log window may show warnings such as, NLS unused message: … in: com.borland. 

These messages can be ignored. 

• The Detail view uses Firefox to display the contents in HTML. An error message containing the phrase 

No more handles … may be displayed if the browser has been updated. Please see http:// 

www-01.ibm.com/support/docview.wss?uid=swg21271865 for more information on how to resolve this 

issue. 

• Only the latest version of StarTeam File Compare/Merge works as an alternate merge/compare tool. 

The 11.0.xxx versions will not correctly auto-merge the file content. Pre-11.0.xxx versions will work, but 

the latest version is recommended. You can download the StarTeam File Compare/Merge installation 

file from the Micro Focus Product Updates downloads site. 

• Alternate Property Editors are not available to display as embedded editors and will show in a dialog 

regardless of the embedded editor setting. 

• If you change the Working Folder while the StarTeam Eclipse Plugin is running, it can cause 

Team Synchronization errors. 

• This release will not open the StarTeam Classic perspective in Solaris 10. 

• Solaris cannot open the Annotation View or the Details View. Therefore, annotation hover hyperlinks 

can not be displayed. 

• Solaris does not support embed-able browsers. Therefore, annotation pop-ups in Solaris will not include 

selectable process links. 

• If your monitor's display appearance is set to the Microsoft Windows Classic theme, filter combo boxes 

display incorrectly (too narrow) in the Eclipse UI. The workaround is to use the Microsoft Windows XP 

theme. To change this setting, select Display from the Microsoft Windows Control Panel. The theme is 

set on the Appearance tab. This is an Eclipse bug. For more information, see https://bugs.eclipse.org/ 

bugs/show_bug.cgi?id=155159. 

• If you enable MPX for both the StarTeam Eclipse Plugin and StarTeam Server, and you log on manually 

in the StarTeam Eclipse Plugin, the client prompts you to take advantage of MPX. If your logon is 

performed automatically using stored account information, the client does not display any MPX prompts. 

However, a system job for MPX is started. System jobs handle all MPX events. These jobs are initially 

invisible in the Eclipse Progress view. You can display them by clicking on the drop down view menu in 

the Progress view, selecting Preferences, and checking the option to Show sleeping and system 

operations in the Progress Preferences dialog box. 

• You can only overwrite files with outgoing changes using the context menu Replace with commands. 

For files with incoming changes only, you must first modify the files locally (to make them conflicting) 

before performing a force check-in. 

• When you refresh the status after renaming a folder with a file added to it, the client shows the set of 

changes as an incoming deletion of the folder and an incoming addition of that folder and its new files. 

The local history is disconnected. However, this does not damage the continuity and consistency of the 

remote history on the server. 

• While you can use drag-and-drop to move workspace resources, you cannot use it to share workspace 

resources. This is an Eclipse bug. For more information, see https://bugs.eclipse.org/bugs/ 

show_bug.cgi?id=187972. 

 

 

MPX Known Issues 
• If you receive either of the following errors when installing MPX Cache Agent: 

Error 1723 There is a problem with this Microsoft Windows installer package. A 

DLL required for this install to complete could not be run. Contact your 

support personnel or package vendor. 

WARNING! Failed to 

install Visual C++ 

This happens when you have an old version (2.0) of Microsoft Windows 

installer. Microsoft Windows Installer 3.0 or later is recommended. For 

http://www-01.ibm.com/support/docview.wss?uid=swg21271865
http://www-01.ibm.com/support/docview.wss?uid=swg21271865
https://bugs.eclipse.org/bugs/show_bug.cgi?id=155159
https://bugs.eclipse.org/bugs/show_bug.cgi?id=155159
https://bugs.eclipse.org/bugs/show_bug.cgi?id=187972
https://bugs.eclipse.org/bugs/show_bug.cgi?id=187972
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Runtime Libraries. 

Please make sure to 

run vcredist_x86.exe 

before running MPX 

Cache Agent. 

more information, see http://www.microsoft.com/downloads/ 

details.aspx?FamilyId=32BC1BEE- 

A3F9-4C13-9C99-220B62A191EE&displaylang=en. 

• Checkout data will not be included in the generated .cotrc file if a MPX Cache Agent performed the 

checkout. Data will only be included in the .cotrc file if the check-out operation was performed by the 

StarTeam Server. 

 

 

StarTeam SDK Known Issues 

Installing 

SDK to Use 

REST 

Service 
 
 
 

 
PATH 

Variable 

In order to extract the StarTeamRESTService.war for deployment, install the SDK with 

administrator privileges. Right-click the SDK installer .exe, and choose Run As 

Administrator. 

If deploying the rest services war without installing the SDK as an administrator of the local 

machine, the following error may appear when trying to connect from a browser: "The origin 

server did not find a current representation for the target resource or is not willing to 

disclose that one exists." 

When you install the product on Microsoft Windows, the StarTeam SDK runtime will also be 

installed if necessary. If an error indicates that you must manually edit the PATH system 

variable and refers you to the readme file, the length of the PATH variable on the target 

computer has exceeded the Microsoft Windows maximum. You must shorten the text and 

either include the new path for the StarTeam SDK runtime or run the StarTeam installer a 

second time. The PATH system variable cannot exceed 1024 characters. The 1024 

characters must include the StarTeam SDK runtime paths which, by default, are C: 

\Program Files\Micro Focus\StarTeam SDK <version>\bin and C:\Program 

Files\Micro Focus\StarTeam SDK <version>\lib. 

   Note: Removing text from the Microsoft Windows path may cause undesired 

application failure. It is very important to be certain that a path is obsolete before 

manually deleting it from the PATH system variable. If you are uncertain, please use 

the obsolete application's uninstaller or consult your system administrator before 

taking any action. 

 

 

StarTeam Git Client Known Issues 
• Pushing a branch in Git created by checking out a tag to StarTeam is not supported. 

• Pushing a Git commit containing both rename or move folder operations and file modifications is not 

supported. As a workaround, ensure that rename or move folder operations are committed separately 

from file updates before pushing to StarTeam. 

• SmartGIT and GIT GUI client are not supported in this release. 
 

 

StarTeam Server Known Issues 

Linux Server does  not support AutoPass License Server 

Linux versions of StarTeam Server does not support AutoPass License Server. 

http://www.microsoft.com/downloads/details.aspx?FamilyId=32BC1BEE-A3F9-4C13-9C99-220B62A191EE&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=32BC1BEE-A3F9-4C13-9C99-220B62A191EE&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=32BC1BEE-A3F9-4C13-9C99-220B62A191EE&amp;displaylang=en
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Server Administration Tool Crashes with Oracle Instant Client 

StarTeam Server does not support any version of Oracle Instant Client. The Server Administration Tool crashes when 

clicking Verify Connection after choosing the direct database connectivity option. 

Search Issue 

Search may not work when using Atlas Planning and Tracking Suite 3.2.1 with Atlas Hub 16.0. 

 
64-bit Linux Server running an un-patched version of SUSE 11.3 or 11.4 is unable to load Event 

Transmitter with ActiveMQ 

This can be resolved by either applying the security patch, or by creating symbolic links in StarTeam Server 

folder to the older versions of these files. The syntax for creating symbolic links is: 
 

 
 

 

32-bit Linux Server 

In order to open Server Administration Tool in 32-bit version of Linux Server, it is necessary to install the 

compatible Open LDAP 2.3 library for SUSE 11 SP3 and RHEL 6.7. 

• For SUSE 11 SP3 32-bit the library is compat-libldap-2_3_0 version number 2.3.37_2.24.36. 

• For RHEL 6.7 32-bit the library is compat-openldap-1:2.3.43-2.el6. 

 
Oracle 12c on 64-bit Linux Platform 

When using Oracle database version 12c on a 64-bit Linux platform for StarTeam Server configurations, 

ensure that the Oracle client being used is also of the same version (12c). Using an older version of Oracle 

client, like 11.0, crashes Admin Tool while attempting to connect to the database. 

 
ODBC/DSN Decommission Process and the workaround 

During the database upgrade process for existing pre-13.0 configurations, the ODBC DSN information in 

the configuration file is replaced with entries for direct database connectivity. During this time, we are able 

to detect the database server and instance name and update the configuration accordingly. 

Connecting to a database (Microsoft SQL Server or Oracle) running on a non-default port is now supported 

directly during the creation of a new configuration. There is an option to select the port, if desired. However 

for Microsoft SQL Server configurations upgraded to 12.0 from previous versions of StarTeam, the default 

port will always be assumed. This is because the workaround to connect to a Microsoft SQL Server on a 

non-default port using ODBC does not return the port information when queried. 

If attempting to upgrade an existing configuration to the latest, where the Microsoft SQL Server ODBC DSN 

used by the existing configuration references a non-default port, it may be necessary to edit the StarTeam 

Server configuration file to enter the correct port. 

 
Installation Issues 

Multiple SDKs 

on 64-bit OS 

If you install multiple SDKs on a 64-bit OS (one 32-bit and one 64-bit), the shortcuts for 

the first SDK will be overwritten with the shortcuts to the last SDK installed. This means 

that you can only uninstall the 'last' SDK using the shortcuts in the program group. 

Linux On Linux, selecting the Embed Preedit String into client window option is preventing 

input into the Password field in the Japanese language (like it was in previous 

releases), and also in the English language in this release. French and German are 

fine. We recommend you uncheck the Embed Preedit String into client window 

option in both English and Japanese languages. 

ln -s /usr/lib64/libcrypto.so.0.9.8 ./libcrypto.so.10 
ln -s /usr/lib64/libssl.so.0.9.8 ./libssl.so.10 
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Server Issues 

Native-II 

Vault 

 

 
Disk volumes used for hives by one StarTeam Server configuration should not be used by 

any other process including other StarTeam Server configurations. 

Hive threshold limits should never be set to 100%. You should never totally fill a drive 

anyway, but when a hive is set to 100% and runs out of disk space, the Server still checks 

this hive when it is this hive's turn in the hive rotation. The resulting error is: no space 

left on device. The workaround is to clear the Allow new archives check box in 

Hive Manager for this hive. 

Time Issues StarTeam Server stores time stamps in UTC (also known as Universal Coordinated Time, 

Greenwich Time, or Zulu Time) format and adjusts the time stamp for the time zone that 

the computer specifies. For example, if a file is saved and checked in at 5 P.M. in 

California, its time stamp in California is 5 P.M. However, its time stamp on a computer in 

New York would be 8 P.M., the time it was in New York when the file was checked in. 

When a file is modified, the time stamp reflects that of the operating system. This means 

that if a file is checked in by a user in one time zone and modified by a user in another, the 

file's time stamp may appear to be earlier than the most recently checked-in revision. This 

does not affect file statuses within StarTeam because the UTC times are used to calculate 

statuses. 

If you are in an area that observes Daylight Savings Time (DST), the StarTeam status bar 

may display the incorrect time when rolling back a view (ViewSelect 

ConfigurationConfiguration As Of). For example, if you are currently in DST and 

rollback the view to a point in time prior to DST, the time display in the status bar (lower 

left corner of the StarTeam window) will be ahead by one hour. If you are not currently in 

DST and rollback the view to a point in time during DST, the time in the status bar will be 

behind one hour. 

Microsoft 

Project 

Tasks 

Disk-Imaging 

Software 

 
 
 
 
 

Logging in 

Using 

Previously 

Logged on 

User 

Microsoft Project tasks imported into a StarTeam Server should not have work records 

that occur before the start date. If they do, the work hours will not be subtracted from the 

remaining work. 

Disk-imaging software, such as Norton Ghost, does not work well with StarTeam. 

StarTeam needs to be installed on each workstation. StarTeam creates a unique 

connectionmanager.ini file for each workstation. The connectionmanager.ini is 

used to identify one workstation from another. If you use disk-imaging software, this .ini 

file is copied, and when the image is installed to another computer, there are now two or 

more workstations with the same .ini file. This can lead to unusual status problems. 

When working in the Server Administration tool and logging in using a previously logged 

on user, an error displays indicating that A user has already been logged on 

for this session. As a workaround, close and reopen the Server Administration 

tool and log on again. Click OK to terminate the program. 

To avoid this situation, be sure to stop the StarTeam Server application before shutting 

down Microsoft Windows or run the StarTeam Server as a service. 

 

 

StarTeam Layout Designer Known Issues 

Buttons and Drag 

and Drop 

Components Do Not 

Work on Linux 

On Linux systems, when attempting to create a new layout and add new 

components using the sidebar or dragging and dropping them from the left menu, 

the functions do not work. The issue happens for all types of layouts: Change 

Request, Task, Story, etc. To work around the issue: 

1. Select a generic control from the palette to the right of the control list. 
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2. Open the Property page. 

3. Right-click and choose Paste. 

This creates the control window, which you can then expand/collapse. 

Refer to the Layout Designer User's Guide for more information. 

 
 

StarTeam Quality Center Synchronizer Known Issues 

• StarTeam Quality Center Synchronizer support for Oracle requires ojdbc7.jar to be installed on the 

same computer where StarTeam Quality Center Synchronizer is installed. Make sure to install an Oracle 

client on the same computer as StarTeam Quality Center Synchronizer. The Oracle client that supports 

ojdbc7.jar is Oracle 12c client. 

• StarTeam Quality Center Synchronizer support of ALM 12.5 using Oracle requires an edit to run.bat 

and run-again.bat. You must change the ORACLE_PATH line in the batch to match the installation of 

the Oracle 12c client installation directory. Change the ORACLE_CLASSPATH line from classes12.zip 

to ojdbc7.jar. 

• Change Requests that are created in StarTeam and synchronized to Quality Center with a required field 

in Quality Center need to be map to a StarTeam field that must have a value. The fields in the bug.ini 

that are required fields in Quality Center must be set to use an equal sign (=) in the mapping information 

of bug.ini. Required fields in Quality Center must have history enabled because of the share 

ownership option that is enable in the bug.ini for StarTeam Quality Center Synchronizer. 

• Large synchronizations may result in out of memory errors. In these cases, we recommend adding - 

Xmx256m (or up to -Xmx1024m, depending on available resources) to the following line in run.bat or 

run-again.bat. 
 

 
 

such that it reads: 
 

 
• If the LookupList field value is also the name of the list, the StarTeam Quality Center Synchronizer will 

not create that value in the corresponding StarTeam enumerated field, but instead generates an error. 

The workaround is to manually add the value to the actual list in StarTeam Quality Center Synchronizer. 

• The 2005 R2 StarTeam Quality Center Synchronizer allowed an empty Quality Center field mapped to a 

StarTeam enumeration to result in the StarTeam enumeration having an empty value. This was 

accomplished by setting the value of the StarTeam enumeration to 0 or -1. This functionality has been 

removed because these values are not allowed by the StarTeam client. If the Quality Center value is 

empty and is mapped to a StarTeam enumeration, the default value of the enumeration in StarTeam will 

be used. Even if the mapping is owned by Quality Center, if the value in StarTeam is empty, the 

StarTeam change request will be updated with the default value. In the 2005 R2 StarTeam Quality 

Center Synchronizer, if the vts_create_custom_fields directive was used to create an 

enumeration field in StarTeam, these newly created enumeration fields did not have the default value 

correctly set. If such a property is encountered during synchronization, a warning message is generated 

indicating that the user should use a 2006 or later client and set the default value in the customize 

dialog. If a Quality Center field is mapped to a StarTeam enumeration and that Quality Center field 

allows blanks, a warning is generated indicating that the user should customize the Quality Center field 

to make it Required. 

• Quality Center does not convert times to local time when the Quality Center server is running in a 

different time zone than the StarTeam Quality Center Synchronizer, so times must be translated into the 

time zone of the server. Quality Center now performs the translation based upon a time zone ID code 

that specifies the time zone of the Quality Center server. 

• For 12.5 you need to download HP ALM Connectivity Tool first, then go to http:// 

10.50.3.14:8080/qcbin/TDConnectivity_index.html and click the Download HP ALM 

%JAVA% -classpath "%_CLASSMATE% com.starbase.mtdsync.App BugSync.ini 

%JAVA% -Xmx256m -classpath "%_CLASSPATH% com.starbase.mtdsync.App 
BugSync.ini 
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Connectivity link. After that, register the DLLs for QCSync to use. Otherwise, you will get Unable to 

load QC jar error. The two DLLs you need to register are: 

• regsvr32 C:\Users\yet\AppData\Local\HP\ALM-Client\12.50.0.0\OTAClient.dll 

• regsvr32 C:\Users\yet\AppData\Local\HP\ALM-Client\12.50.0.0\webClient.dll 

 

 

StarTeam Visual Studio Plugin Known Issues and 

Limitations 

Known Issues 

• Occasionally, using StarTeam File Compare/Merge stand alone or running the compare/merge inside 

Visual Studio throws the following exception: "Could not find any JRE". To work around this issue, 

ensure that set system environment variable JAVA_HOME is set correctly. For example: 

JAVA_HOME= C:\Program Files\Micro Focus\Java\Oracle1.8 

• Component types for Atlas and StarTeam Agile, as well as custom component types, are now visible 

tabs in the StarTeam Visual Studio Plugin. While the Micro Focus web interfaces for these tools provide 

the preferred editing capabilities, if you would like users to be able to edit any of these item types from 

within Visual Studio, then an appropriate custom editor (either via Layout Designer or Alternate Property 

Editor) should be created and will be picked up by the StarTeam Visual Studio Plugin. 

  Note: Rich text edit boxes on Custom Editors will not display in Visual Studio. 

• The StarTeam Visual Studio Plugin Plugin does not support source code operations on Web Site 

projects that use a local IIS server. This is a known bug. There is no workaround other than using the 

embedded client and pointing it to the local files in the IIS server. 

• When changing the source code provider for a solution from StarTeam SCC (or any SCC provider) to 

the StarTeam Visual Studio Plugin you must unbind the SCC integration using the File > Source 

Control > Change Source Control menu, then set StarTeam Visual Studio Plugin (Tools > Options > 

Source Control) as your source control provider. The system displays the File > Source Control > 

Change Source Control menu only if you have a solution that is bound to an SCC provider. 

• When the connection to MPX has been broken for solutions or projects placed into StarTeam Server 

with MPX enabled, using the integration commands Update Solution or Refresh does not work. As a 

workaround for this issue, you can either: 

• Log off and log on to the StarTeam Server. 

• Perform a manual refresh using the StarTeam Refresh command or the Refresh button in the 

StarTeam Items or StarTeam Folders pane. 

• Rich text support appears to be in place when copying and pasting text, images, or hyperlinks into text- 

based fields for a Change Request, Task, Topic, or Requirement. Once the item is saved to the 

StarTeam Server, the formatting and images are removed. 

• When upgrading projects from the 2005 version of StarTeam Visual Studio Plugin to this integration, 

one person needs to migrate the project and check in the changes. That user must have the project and 

solution files current on disk so that they have the StarTeam sync records and no Unknown file statuses. 

After that, all users must pull the project or solution to their workspace for use in Microsoft Visual Studio 

2012. You will get an error message if you try converting your Microsoft Visual Studio 2005 project to a 

Microsoft Visual Studio 2012 project by using the StarTeam > Pull Solution (or Pull Project) 

commands in Microsoft Visual Studio 2012. Perform the steps in the following example instead. For 

example: 

1. Open the StarTeam Cross-Platform Client (or Microsoft Windows client) and open the Microsoft 

Visual Studio 2005 project. Make sure that none of the files have an Unknown status. If any files 

have this status, select them, and choose File > Update Status from the main menu. If the files are 

not in your workspace, you will see a Missing status. In this case, you must check them out. 



Known Issues | 49  

2. Open the Microsoft Visual Studio 2005 .sln file in Microsoft Visual Studio 2012. Doing so 

automatically opens the Conversion wizard which converts the Microsoft Visual Studio 2005 

solution and project files so that they can be used in Microsoft Visual Studio 2012. 

3. After completing the steps in the wizard, the solution and project files are marked as Modified by 

StarTeam. Choose StarTeam > Pending Checkins window to check in the files. 

4. Advise other users to open Microsoft Visual Studio, and choose StarTeam > Pull Solution (or Pull 

Project) to bring the files to their own respective workspaces for use in Microsoft Visual Studio. 

• If you have a locally-modified file open and another user renames that same file and checks in the 

changes (including the solution file) and then you update the solution, you must manually merge the file 

from your local workspace with the renamed file to make sure that all of your changes are preserved. 

Additionally, you will no longer see the file by its original name in the Solution Explorer (your original file 

with its changes still exists in your local workspace), and you might see an error message if you have 

the file open in the Designer. 

• Unlike Visual SourceSafe, you must save your files so that changes are recognized by the integration 

before accessing most StarTeam file commands. However, changes are automatically saved when 

using the StarTeam Place Solution, Place Project, Update Solution, Update Project, or Commit 

Project commands. 

• If you use the options to either exclusively or non-exclusively lock files on check-out (found in the File 

tab of the StarTeam Personal Options dialog), and you check out but do not modify files or if you 

modify files and revert your changes, the files will not appear in the StarTeam Pending Checkins dialog. 

In this case, the files remained locked until you manually unlock them. This behavior differs from Visual 

SourceSafe where the check in dialog displays locked files and the check in operation unlocks 

unmodified files. 

• Sometimes the Project Load Failure dialog box displays when you pull the project, but it can be 

ignored. The solution opens anyway. 

 
Limitations 

• In the embedded client, the following new custom field types are not available: Boolean, Content, Date, 

Map, Group, Group List, Time span, User, User List, and Multiple Enumerated. 

• You cannot view the properties of either a change package or its changes in the Changes tab of the 

StarTeam Visual Studio Plugin embedded client, but you can view this information in the Change tab of 

the StarTeam Cross-Platform Client. 

• The StarTeam Cross-Platform Client is optional software, but you cannot use the Launch Client menu 

item from the StarTeam menu if it is not installed. If the menu item is selected, but the StarTeam Cross- 

Platform Client is not installed, StarTeam generates an error message. 

• Changing the working folder in the StarTeam Visual Studio Plugin does not change the alternate 

working folder in the StarTeam Cross-Platform Client. 

• On Microsoft Windows Vista and Microsoft Windows 7, the default installation folder for the StarTeam 

File Compare/Merge component is C:\Users\Public\Micro Focus\File Compare Merge. If 

you change that location during installation, you must select a folder that all users can write to. 

 

 

StarTeam Web Client Known Issues 
• Light Weight Views are not supported in 17.0 . They will be supported in a future release of StarTeam. 

• From 17.0 release onwards , MicroFocus does not ship the Oracle JRE 1.8. Customers using Web APE feature can 
continue to work with Oracle JRE as the Web client installer does not uninstall the existing installation of Oracle 
JRE. Customers who expect launch Web APE from machines other than the Web client machine would need to 
install the Oracle JRE 1.8.  

• When using Edge browser, file service is not recognized as running even after it is started. 

• StarTeam Web Server must be connected to an actual IP Address or Host Name for search to work 

in StarTeam Web Client. Do not use localhost. 

• There is a known issue when checking in files from the web client. The first time a file is checked in, the 

File Time Stamp at Check-In field will not be populated, and will be displayed as "N/A". A subsequent 

check-in will update the time stamp correctly. 
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• There is a known issue when using non ASCII characters as the View Root Folder. Using non ASCII 

characters will result in incorrectly named folders being added to disk on check out. Therefore, please 

use only ASCII characters for folder names when setting the View Root Folder. 
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• If you access the StarTeam Web Client and the user interface is not in the language expected, you 

can specify the language by adding the locale as a request parameter. For example: http:// 

<server_name_and_port>/StarTeam/?locale=ja 

This will change the user interface to be rendered in Japanese. Changing the request parameter to: 

locale=fr, will render the user interface in French, and so on. 

• If you are using non-latin characters for file and folder names, the following update to the tomcat 

configuration needs to be made: 

1. Open the <installed web server location>/apache-tomcat-[version]/conf/ 

server.xml file. 

2. Search for the Connector element. 

3. Add URIEncoding="UTF-8" to the Connector element: 
 

 
4. Save the server.xml file. 

5. Restart Tomcat if it is currently running. 

• If you access StarTeam Web Client using a hostname-only web address (for example http:// 

starteam) using Internet Explorer 9, you may see an error message Your browser does not 

support CORS while using the file features. Internet Explorer 9 uses a Compatibility Mode to help 

display older intranet sites correctly, unfortunately this behavior interferes with the correct functionality of 

the StarTeam Web Client. There are two workarounds: 

• Access the application using a full web address (for example http:// 

starteam.mycompany.com). 

• Set Internet Explorer 9 to not display intranet sites in compatibility mode (instructions available here: 

http://blogs.msdn.com/b/ie/archive/2009/06/17/compatibility-view-and-smart-defaults.aspx). 

• Shutting down the File Service from the taskbar will not cancel any file operations that are currently 

under way. The File Service will stop once the operations have completed. Alternatively, the File Service 

may be shutdown immediately using Microsoft Windows Task Manager. 

• Item properties of the types: Content, Map, Multi-Select Enumeration, Boolean, and Date cannot be 

edited in the StarTeam Web Client 13.0. 

• On the first attempt to view Item Properties for a specific type of Item, if multiple Items are selected 

then the StarTeam Web Client will display a warning that the editor file could not be found. After closing 

this warning, the editors display correctly and further attempts to open editors of this type will not 

display the warning. This issue is not present if only a single Item is selected for editing the first time. 

 

 

StarTeam Web Server Known Issues 
• StarTeam Web Server must be connected to an actual IP Address or Host Name for search to work 

in StarTeam Web Client. Do not use localhost. 

• When administering the StarTeam Web Server for multiple combined StarTeam repositories that add up 

to more than 1000 projects, you must use Mozilla Firefox 10.0.2 or greater. All other browsers fail or 

lock-up when trying to load the Web Server Administration user interface. 

• The first person to log into a project that contains over 100 views will experience a load delay that could 

last several minutes depending on the quantity of views. This is a one-time cost for the project. No other 

user will experience the delay unless the StarTeam Web Server is restarted. 

• On Microsoft Windows Server 2008, sometimes the StarTeam Web Server installation will fail to copy 

the required libraries from the StarTeam install location to the StarTeam Web Server install location. If 

this occurs, the files must be manually copied from the SDK to the StarTeam Web Server. Copy the 

following files to YOUR_PATH\StarTeam <version> Web Server\apache-tomcat-[version] 

\shared\lib: 
 

 

<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000" 

redirectPort="8443" URIEncoding="UTF-8" /> 

YOUR_PATH\StarTeam SDK <version>\lib\ss.jar 
YOUR_PATH\StarTeam SDK <version>\lib\starteam130.jar 

http://blogs.msdn.com/b/ie/archive/2009/06/17/compatibility-view-and-smart-defaults.aspx
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• When the StarTeam Web Server is installed as a service, sometimes it may fail to stop. This can 

happen when the StarTeam Web Server is configured to support over 1000 projects. The process will 

exit, but Microsoft Windows will show a failed error message. 

• Default memory settings may be insufficient for very large data-sets (>1000 projects). There are two 

files that may need to be modified before the StarTeam Web Server can be started, depending on the 

action you perform: 

Running as 

a Service 

 
 
 
 
 
 

Running 

from the 

Start Menu 

Edit either the file: YOUR_PATH\StarTeam <version> Web Server 

\StarTeamService32.bat or YOUR_PATH\StarTeam <version> Web Server 

\StarTeamService64.bat depending on your operating system. Change the value 

of JVM_MAX_MEMORY to a value of your choice (in megabytes). For 32-bit operating 

systems, a maximum of approximately 1.8 GB is generally the limit. The JAVA_HOME 

and PRODUCT_JVM variables should be validated for accuracy. They are set 

according to typical path locations. 

Edit the file: YOUR_PATH\StarTeam <version> Web Server\ apache-tomcat- 

[version]\bin\setenv.bat. Change the value of -Xmx4096M to a value of your 

choice (in megabytes). For 32-bit operating systems, a maximum of approximately 1.8 

GB is generally the limit. The JRE_HOME variable should be validated for accuracy. It 

is set according to typical path locations. 

• Properties whose values are Deleted Users will display as Deleted User in the StarTeam Web 

Client. 

 

 

TeamInspector Known Issues 

Installation and 

Configuration 

 
• Cancelling the installation when TeamInspector is in the process of copying the 

installation files to the server can result in a situation in which TeamInspector fails to 

clean up all files. The TeamInspector directory, and Uninstall_TeamInspector 

directory, as well as an install.log and other files remain. If you experience this 

problem, manually remove the remaining directories and files before attempting 

another installation of TeamInspector. 

• During installation, pressing the Cancel button when in the Database Connection 

panel causes the installation to terminate but fails to clean up the TeamInspector 

installation directory. Manually remove the TeamInspector installation directory and 

files before attempting another installation of TeamInspector. 

• If reinstalling or upgrading TeamInspector, you might experience a general logon 

error when you attempt to launch the TeamInspector application from your client 

computer. If you encounter this error, try clearing the cookies in your web browser. 
 

Builds • If running builds of large, multiple projects in TeamInspector, you might experience 

an out-of-memory problem. If this problem occurs, an out-of-memory exception is 

logged in a TeamInspector log file, such as the teamInspector-master.log or 

teaminspector-job.log. If you encounter this issue, increase the Java Heap 

size in the following TeamInspector wrapper files: master-wrapper.conf, job- 

wrapper.conf, and web-wrapper.conf. 

• See Troubleshooting Build Failures in the online help for additional information. 

YOUR_PATH\StarTeam SDK <version>\lib\starteam130-resources.jar 

YOUR_PATH\StarTeam SDK <version>\lib\StarTeam.Encryption.dll 

YOUR_PATH\StarTeam SDK <version>\lib\StarTeam.Environment.dll 

YOUR_PATH\StarTeam SDK <version>\lib\StarTeam.FileAccess.dll 
YOUR_PATH\StarTeam SDK <version>\lib\StarTeam.Profile.dll 
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Documentation The first time you open the TeamInspector online help system from the product 

interface, the Table of Contents (TOC) opens collapsed, instead of in expanded mode 

in which all top-level headings in the help system are displayed. 

To expand the contents in this pane and view the top-level topics, click on the plus sign 

next to the TeamInspector book icon. You can then expand any of the topics displayed 

to view a list of the sub-topics available under each heading 

Thereafter, when you click the help icon on a page or from a dialog box the help 

system opens to the topic in context with the page or dialog screen that you are 

viewing. 

 

 

StarTeam Microsoft SCC Integration Known Issues and 

Installation Notes 

Known Issues 

• The integration and PowerBuilder use separate Java VMs. Micro Focus recommends using 

PowerBuilder .NET version 11.2 to avoid Java VM conflicts. 

• When you connect to a source control system, PowerBuilder instantiates a Java VM by default. For 

certain source code control (SCC) programs, such as StarTeam or TrackerLink, the Java VM 

instantiated by PowerBuilder conflicts with the Java VM instantiated by the SCC program. To prevent 

Java VM conflicts, add the following section and parameter setting to the PB.INI file: 
 

 
• You do not need to install the StarTeam Cross-Platform Client on the workstation running SCC. 

However, the SCC integration does not provide a way for you to change any personal options or project 

properties. Settings that do exist are in effect. 

• To use alternate property editors (APEs) for a project, you must install the StarTeam Cross-Platform 

Client and configure it to use the APEs. 

• If you plan to use StarTeam and the StarTeam 2008 Release 2 Microsoft SCC integration with Visual 

Basic 6.0: Copy the ssvb.dll and ssus.dll files from Visual SourceSafe to the Windows System32 

folder. These files are usually found in C:\Program Files\Microsoft Visual Studio\Common 

\VSS\win32, but ssus.dll may also be in C:\Program Files\Common Files\Microsoft 

Shared\vs98 or C:\Program Files\Microsoft Visual Studio\VIntDev98\bin. 

• In order to enforce process rules, select the process item as part of the check-in operation. 

 
Using Beyond Compare with the Integration 

To use Beyond Compare with this version of the integration: 

1. You must have Sun Microsystems Java Virtual Machine 1.5.0_09 installed in the C:\Program Files 

\Micro Focus\Java folder. If you installed a previously-released version of the integration, this 

version of the JVM is already installed on your system. If you do not have this version of the JVM 

installed, then install the StarTeam 2006 Release 2 SDK (which uses this JVM). 

2. Create a file named sdkapp.ini. 

3. Add the following information to the sdkapp.ini file: 
 

 
4. Save the sdkapp.ini file in the Beyond Compare installation folder. When loaded by Beyond 

Compare, this file forces the integration to use JVM 1.5.0_09. 

[JavaVM] 
CreateJavaVM=0 

[Java VM] 
Name=Sun1.5.0_09 
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Installation Instructions 

1. Download the file from the Micro Focus download site. 

2. Double-click the file. 

3. Follow the directions on the screen. 

The default installation location is C:\Program Files\Micro Focus\StarTeam Integrations 

\StarTeam Microsoft SCC Integration. 

 
 

Micro Focus Pulse Code Review  

Known Issues 

 

 When a user checks in a change against a process item from a different view, the Review gets generated 
against the change package and not against the process item. Any subsequent checkins against the same 
process item generates new Reviews since they are not against the process item.  

 Once a Reviewer is added to a Review, the Review is published automatically. In order to add/remove 
additional Reviewers, the Review has to be sent to Rework state.  
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Contacting Micro Focus 

Micro Focus is committed to providing world-class technical support and consulting services. Micro Focus 

provides worldwide support, delivering timely, reliable service to ensure every customer's business 

success. 

All customers who are under a maintenance and support contract, as well as prospective customers who 

are evaluating products, are eligible for customer support. Our highly trained staff respond to your requests 

as quickly and professionally as possible. 

Visit http://supportline.microfocus.com/assistedservices.asp to communicate directly with Micro Focus 

SupportLine to resolve your issues, or email supportline@microfocus.com. 

Visit Micro Focus SupportLine at http://supportline.microfocus.com for up-to-date support news and access 

to other support information. First time users may be required to register to the site. 

 

 

Information Needed by Micro Focus SupportLine 
When contacting Micro Focus SupportLine, please include the following information if possible. The more 

information you can give, the better Micro Focus SupportLine can help you. 

• The name and version number of all products that you think might be causing an issue. 

• Your computer make and model. 

• System information such as operating system name and version, processors, and memory details. 

• Any detailed description of the issue, including steps to reproduce the issue. 

• Exact wording of any error messages involved. 

• Your serial number. 

To find out these numbers, look in the subject line and body of your Electronic Product Delivery Notice 

email that you received from Micro Focus. 

 

 

Creating a Dump File 
If reporting a protection violation you might be asked to provide a dump ( .dmp) file. To produce a dump file 

you use the Unexpected Error dialog box that is displayed when a protection violation occurs. Unless 

requested by Micro Focus SupportLine, leave the dump setting as Normal (recommended), click Dump, 

then specify a location and name for the dump file. Once the dump file has been written you can email it to 

Micro Focus SupportLine 

You may also be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a tracing 

infrastructure that enables you to quickly and easily produce diagnostic information detailing the operation 

of a number of Micro Focus software components. 

 

 

Creating Debug Files 
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine, 

your support representative might request that you provide additional debug files (as well as source and 

data files) to help us determine the cause of the problem. If so, they will advise you how to create them. 

http://supportline.microfocus.com/assistedservices.asp
mailto:supportline@microfocus.com
http://supportline.microfocus.com/
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Licensing Information 
This product includes software developed by the Indiana University Extreme! Lab (http:// 

www.extreme.indiana.edu/) and software developed by the Apache Software Foundation (http:// 

www.apache.org/). 

http://www.extreme.indiana.edu/)
http://www.extreme.indiana.edu/)
http://www.apache.org/)
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